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Introduction to Vector Issue Tracker 

Vector Issue Tracker is a flexible, Web-based system for centrally tracking 

and managing issues and calls. Vector Issue Tracker is a template of the 

Vector Issue Tracker Engine. Because it is Web-based, it enables users to 

access the issue database from any browser, anywhere, any time. It also 

minimizes deployment effort because there is nothing to install on the PCs it 

supports. 

Vector Issue Tracker works like a Windows application rather than a set of 

static HTML pages that must be constantly updated and reloaded. This 

enables you to easily customize Issue Tracker to suit the way you want to 

work. When you run a query, view an issue, or submit a new issue, Vector 

Issue Tracker dynamically updates its interface. It uses pop-up dialogs for 

tasks like generating reports and attaching files to records. 

Terminology 

The following terms are used to refer to Vector Issue Tracker components: 

Projects are databases or knowledge bases. All Projects share user 

accounts, user group privileges, and the administration utilities, but each 

Project has a separate database. 

Web views are customized views of Project databases. Each Web view is 

designed to meet the needs of a class of users. For example, employees who 

do not belong to the support department only need to see the issues they 

submitted, not all the issues in the Project database or the notes added by the 

support staff. Conversely, support staff need access to all the issue 

information in the Project database. 
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The Components 

Issue Tracker Server houses the shared databases that contain the issues 

and definitions (such as queries, reports and layouts) for a Vector Issue 

Tracker Project. It must be installed on a Web server (a PC running IIS - 

Internet Information Services)  

 

Issue Tracker Web is a Web-based application through which users enter 

issues, query the database, and generate reports.  

 

Issue Tracker Admin is a Microsoft Windows application for administering 

Vector Issue Tracker Projects. For example, you use Issue Tracker Admin to 

create Projects, customize the issue fields, and set up e-mail notifications. 

You can install Issue Tracker Admin on any PC running Microsoft Windows, 

including your Web server. Typically, you install Issue Tracker Admin on a 

single system from which you manage Vector Issue Tracker. 

 

Web Admin is a Web-based administration tool. It allows remote users (with 

privilege) to administrate Vector Issue Tracker using a Web browser. Using 

Issue Tracker Web Admin you can add and edit users, define workflow rules, 

create new tabs, set up choice fields, and configure SLA and e-mail 

integration. 

 

Web View Editor is a Microsoft Windows application that enables you to 

create Web Views for your Vector Issue Tracker Projects. Web Views are 

HTML/ASP pages that provide access to Vector Issue Tracker Projects 

through a Web browser.  

 

Import Users Accounts is a Microsoft Windows application that allows you 

manage the integration of your Domain or Active Directory user accounts with 

Issue Tracker. 
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Issue Tracker Architecture 

Vector Issue Tracker Architecture Diagram 

As Vector Issue Tracker is a Web based product, the architecture is relatively 

simple. All of the components below should be located on one Server. 

Single Tier Installations 

 

                    

 

 

 HelpDesk Server 

 HelpDesk Web Server 
 

 HelpDesk Admin (workstation or 
server) 

 HelpDesk Web View Editor 
 

 SQL Database Server 
 

 E-mail Integration 
 

 Web Browser (for accessing HelpDesk 
Web and HelpDesk Web Admin) 

 

 HelpDesk Admin (workstation or server) 
 

Workstations 

 

Web Server + 
Database Server 
Mail Server 
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Multi-Server Setup  

Vector Issue Tracker architecture supports the following multi-server 

architecture.  

To install this configuration several items need to be manually configured on 

each server. 

 

                    

 

 

 

 

 

 SQL Database Server 
 

 HelpDesk Web Server 

 HelpDesk Server  

 HelpDesk Web View Editor   

 HelpDesk Admin (workstation or 
servers)  

 

 Web Browser (for accessing 
HelpDesk Web and HelpDesk 
Web Admin) 

 

 HelpDesk Admin (workstation or 
servers) 

Workstations 

 

Web Server 

 

Database Server 

E-Mail Server 
 

  HelpDesk E-mail 
Integration  
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Issue Tracker Architecture 

Issue Tracker functions by using a combination of technologies, some of 

which are located in different places on the disk. This section will aim to shed 

some light on these different technologies, and their respective locations. 

Services 

Services are programs that run in the background; never visible to the user. 

Issue Tracker utilizes three different Windows services, and they all play a 

part in the overall operation of Issue Tracker: 

1. Mq Issue Agent 

This service handles all outgoing mail, and also manages the sending of e-

mail notifications defined in Admin. 

2. Mq Mail Integration Agent 

This service is responsible for reading incoming e-mail from POP accounts, 

as well as executing actions specified in the rules. When it wants to send 

outgoing mail, it does so through Mq Issue Agent – it never sends e-mails 

itself. 

3. Mq SLA Evaluator Agent 

This service is responsible for evaluating issues, and monitoring their service 

agreement compliancy. It will handle the process of escalating issues, as well 

as any other actions that are SLA-related.  

These services can be manually stopped and started from the Windows 

Services configuration screen, though this usually only necessary when the 

server is under maintenance. 

Important Folders 

Issue Tracker uses files that are placed in a few different locations: 

1. C:\Program Files\Common Files\MetaQuest 

This folder contains the majority of the DLLs required by Issue Tracker to 

function.  The executables behind the services are also located in this folder.  

2. C:\Program Files\Vector\IssueTrackerTools 

This folder contains the Web View Editor, Issue Tracker Admin, Import Users 

tool, and other tools. 

3. C:\Program Files\Vector\IssueTrackerServer 

 The main Issue Tracker folder – by default, it contains: 

 Web views 

 Attachments (Issue, E-mail, E-mail Template) 

 Databases (Projects, Global) 
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This folder is particularly important, and so it will be covered further in the next 
section. 

IssueTrackerServer Folder 

To better understand how Issue Tracker structures the IssueTrackerServer 

folder, let’s take a look at how a project and its web views are represented 

within it. Let’s assume we have a project called “HelpDesk”, and it has a view 

called “Employee”. Let’s also assume that the view has already been 

generated. 

Project Databases 

By default, the project databases will be created in the IssueTrackerServer 

root (C:\Program Files\Vector\IssueTrackerServer), with the following naming 

convention – where <project> is the name of the Vector Issue Tracker project: 

 <project>01.dat 

The DAT database file contains, generally, most of the data saved in Issue 

Tracker. For example, issues, attachment information, notifications, e-mails, 

pending outgoing e-mails, etc. 

 <project>02.def 

The DEF database contains most of the definitions. For example, it holds e-

mail integration information, service level agreements, fields, sorts, queries, 

report information, etc. 

 <project>03.usr 

 Used by Issue Tracker Admin. 

 <project>.cen 

  

In our example, this would result in: 

 HelpDesk01.dat 

 HelpDesk02.def 

 HelpDesk03.usr 

 HelpDesk.cen 
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If you are using SQL Server, the names and extensions of the files will be 

different. Also, the DAT and DEF databases may not be located on the same 

machine as the Issue Tracker installation – it all depends where the 

databases were relocated to during the SQL relocation. The SQL Server can 

also be a different machine from the Issue Tracker server, in which case the 

databases will be located on the SQL Server using the following naming 

convention:  

 <project>01_Dat.mdf 

 <project>01_Dat_log.LDF  

 <project>02_Def.mdf 

 <project>02_Def_log.LDF  

 

In our example, these files would be: 

 HelpDesk02_Def.mdf 

 HelpDesk02_Def_log.LDF 

 HelpDesk01_Dat.mdf 

 HelpDesk01_Dat_log.LDF 

  

Project Data Files 

The project will also have its own folder in the IssueTrackerServer root: 

C:\Program Files\Vector\IssueTrackerServer\HelpDesk 

The folder, by default, will contain all attachments for that project, which 

includes: issue attachments, e-mail attachments, and e-mail template 

attachments.  
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Project Web views 

Web views are stored in another location: 

C:\Program 

Files\Vector\IssueTrackerServer\CensusWeb\Views\CensusWebVD 

 

Each Web view is represented by a folder in the CensusWebVD directory. In 

our example, our Web view is called “Employee”, and the project is called 

“HelpDesk”, so the following folder exists: 

C:\Program 

Files\Vector\IssueTrackerServer\CensusWeb\Views\CensusWebVD\HelpDes

k_Employee 

The folder contains all the files necessary to allow the web view to function. 

Whenever the view is regenerated, this is the folder that will be updated by 

the Web View Editor. 

  

System Files 

Beyond project-specific databases and files, the IssueTrackerServer folder 

also has a few global databases: 

 Censusweb.mdb 

This database contains the Web view definitions and settings. 

 Users.mdb 

This database contains Issue Tracker users, contacts, companies, and 

related security settings. 

 Licenses.mdb 

 Holds license and system information. 

  

In addition to the global databases, Issue Tracker has a few key system files: 

 CenSession.xml 

Contains the location of all the global databases, as well as which database 

engine is being used. 

 CenInfoSession.xml 

 Censys.mdw 

This is a security database for users that are using Issue Tracker 

Authentication instead of Active Directory authentication. 
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CensusUser Account 

Vector Issue Tracker needs a Windows domain account to use for:  

 Anonymous access to the virtual directories on the Web server. 

 Anonymous access is required to run any Web view or Issue Tracker 

Web Admin, which are all stored in virtual directories on the Web 

server.  

 Access to Vector Issue Tracker databases in a distributed 

configuration, where the databases are not on the Web server. 

 Access to attachments, which may be stored on a different computer 

than the Web server. 

 Access to Vector Asset Management site databases 

By default, Vector Issue Tracker uses the CensusUser account, which is 

created when you install Vector Issue Tracker. The default password for the 

CensusUser account is “nd5kvmWJ.nd5kv”.  

The CensusUser account is a Windows domain account, and is created by 

the Issue Tracker setup. 

Note: If you change the password for the CensusUser account, or delete the 

user account and use another one, you must update the virtual directories in 

the Internet Service Manager (Windows NT) or Internet Services Manager 

(Windows 2003, 2000, XP). 

To change the Windows account used for anonymous access to a virtual 
directory:  

1 Open the Web View editor. In the shortcut bar, click URL . 

2 Click Change URL… to open the Web View Wizard and then 
click Next. 

3 Click Advanced, click Update existing virtual directory, and 

click Next. 

4 Click Next until you get to the Virtual Directory Properties 

dialog. 

5 Select the Show Advanced Options check box. 

6 In the User Name box, enter the name of the user account.  

Click Browse to locate a domain user account.  

7 In the Password box, type the user account password. 

8 You can also use Issue Tracker Admin to change the Windows 

account.  

To change the Windows account used by Vector Issue Tracker:  

1 Open Issue Tracker Admin. 
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2 On the Tools menu, click Windows Account. 

3 Enter the name and password of the domain user account you 
want to use. 

This user account is used for anonymous access by all 

subsequent Web views you generate.  

Note: When you change the user account used for anonymous access with 

the Web View Editor, all required permissions and rights are automatically 

set. 

 

IIS (Internet Information Services) 

Issue Tracker requires IIS, a Microsoft Web server, to function properly. The 

Issue Tracker setup will create numerous IIS virtual directories, and if you 

have IIS 6.0, application pools as well. 

 

Virtual Directories 

“A virtual directory is a friendly name, or alias, for a physical directory on your 

server hard drive.” 

- Microsoft IIS Help 

To better understand what a virtual directory is, consider the URL 

http://servername/vit. In this example, “vit” is the virtual directory. It is mapped 

to a physical directory, located here:  C:\Program 

Files\Vector\IssueTrackerServer\CensusWeb\Views\CensusWebVD. 

Issue Tracker creates multiple virtual directories, each with a different 

purpose. Some virtual directories are only used for certain projects, and so 

whenever new projects are created, you might end up with more virtual 

directories in IIS. 
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Web View Virtual Directories 

All Web View virtual directories have anonymous access enabled (using the 

CensusUser user account). 

vit 

- Main, entry point for the system. 

vit00 

- Used for load balancing. 

vit01 

- Used for load balancing. 

vit02 

- Used for load balancing. 

 

Web Admin Virtual Directories 

vitadmin 

- Uses Integrated Windows authentication.  

vitadmin00 

- Anonymous access enabled with CensusUser user account. 
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Application Pools 

Issue Tracker also assigns the virtual directories to specific Application Pools: 

MqWAPAdmin 

  vitadmin 

  vitadmin00 

 

MqWAPViews 

vit 

vit00 

vit01 

vit02 

 

Both of these application pools are configured to run as the Network Service 

user. 

 

Other IIS Features 

 

SSL (Secure Socket Layer) 

Issue Tracker supports SSL certificates, and is ready to use them at any time. 

The procedure for using an SSL certificate for a Issue Tracker Web view is 

essentially the same as the procedure for adding an SSL certificate to IIS. 

This is documented in the following article from Microsoft:  

http://support.microsoft.com/kb/299875 

If you already have the SSL certificate, you may only need to start from the 

section titled “Issue and download a certificate”. 
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IIS MIME Types  

IIS only accepts requests for files with known extensions. If a user attempts to 

access a file whose extension is unknown to IIS, it may return a 404 error in 

the browser. This sometimes occurs when trying to view attachments in Issue 

Tracker. To prevent this, you must add the extension to the MIME Types list. 

To define a MIME type for a specific extension:  

 

 Open Internet Information Services. 

 In the console tree, right-click the virtual directory used for 

attachments (for example, census-BugTrk-Upload) and then click 

Properties. 

 On the HTTP Headers tab, click MIME Types. 

 Click New. 

 In the Extension box, type a file name extension (for example, "ini"). 

 In the MIME Type box, type the MIME type of the file (for example, 

"text/ini”). 

 Apply your changes.  

 

Note: You may need to restart the World Wide Web Publishing Service 

before the changes take effect.  
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Creating a Backup Plan 

When to Back Up 

Back up frequency depends mainly on the type of data. First of all we have to 

distinguish two different types of data:  

 Issues and Contact data (records being tracked) 

 System data (support information, schema, definitions) 

Backing up Issues Data 

This information is dynamic, since it changes every time an Issue Tracker 

user adds, updates, or deletes a record. You should tailor your backup 

strategy to the needs of your business. For example, if it is acceptable to lose 

data in the event of a disk failure, you may not need to perform frequent 

backups. What if your database must be available twenty-four hours a day, 

seven days a week? In this case, your database would have to be frequently 

backed up. The frequency of your backups and types of backups performed is 

determined in large part by the needs of your business.  

Backing up System Data 

System Data is the information normally hidden from the user that allows 

Issue Tracker to work. Examples are: 

 List of Issue Tracker projects are available in a Issue Tracker Server 

 Location of the databases used by a Issue Tracker project 

 Fields used in a Issue Tracker project 

 Fields available in each Web View 

This information is usually changed through Issue Tracker Administrator 

Tools, like Issue Tracker Admin and the Web View Editor. This information is 

usually static, since once a Issue Tracker project is set up it rarely changes. 

Power Customizations are usually static as well. That is, changes made to the 

Web files and scripts do not change often. These files are typically located 

under the CustomizedFiles folder (please refer to the documentation for more 

details about this). 
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How to Back Up Issue Tracker Databases (databases in SQL Server) 

In Issue Tracker, Issues and System Data are in the SQL Server and some 

System data is in other type of files, like XML files. You can do a hot backup, 

which can be done while the system is being used, and a cold backup that 

requires all users to be logged off.  

Live or hot backup using SQL Server tools 

A live backup is done even if the files to be backed up are in use. This is ideal 

for 24 hour a day operations. In this scenario, the Issue Tracker Administrator 

has to use some database specific tools for backing up. 

Back up SQL Server Databases: 

In this scenario, Issues, Users/Contacts and System Data are in SQL Server 

databases. Use the SQL Server built-in back up utility. Select the Issue 

Tracker databases like  

Project01_dat 

Project02_def 

Users_mdb 

Licenses_mdb 

CensusWeb_mdb, etc.  

Please refer to Microsoft SQL Server’s documentation for more information. 

 

Cold backup not using SQL Server tools 

A cold backup is the simplest backup. It involves copying the files to a tape or 

disk that is considered secure enough to be the backup media.  

In this scenario, the Issue Tracker Administrator has to ensure the files and 

databases are not being used before the backup process starts because, as 

with any other application, files in use are not backed up. 

SQL Server databases are not backed up as such, but as regular files, 

backing up the *.mdf and *.ldf files, which are the physical files of SQL Server 

databases. 

In order to be able to copy these files, SQL Server must not be using the files. 

That is, either the SQL Server Service is stopped, or the database is 

temporarily detached from the SQL Server (while the backup is in done). 

How to Back Up Issue Tracker Databases (databases not in SQL Server) 

In Issue Tracker Standard, Issues Data and System Data are in Jet 

databases as well as other type of files. 
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Cold backup 

A cold backup is the simplest backup. It basically consists of copying the files 

to a tape or disk that is considered secure enough to be the backup media.  

In this scenario, the Issue Tracker Administrator has to ensure the files and 

databases are not being used before the backup process starts, because, as 

with any other application, files in use are not backed up. 

Steps: 

1. Ensure the files are not in use: 

 Unload the Issue Tracker Web virtual directories from the Internet 

Services Manager 

- or - 

If there are no other applications affected, stop the World Wide Web 

service from the Services Manager. 

 Stop the Issue Tracker services from the Services Manager. 

 Exit any running instances of Issue Tracker Admin or the Web View 

Editor. 

TIP: you can log off users through the Logons Editor in Issue Tracker Admin. 

 

2. Back up the Issue Tracker Server folder and all the files inside with the 

exception of the AccessRT folder, which contains the setup program for 

the Microsoft Access Runtime. 

You can do this using any standard backup tool in the market, such as 

Backup Exec, Backup NOW!, or some Computer Associates tools. 

Note: If you have any Issue Tracker Project in another folder outside the 

Issue Tracker folder, remember to back up those files as well. 
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Live or hot backup 

A live backup is done even if the files to be backed up are in use. 

In this scenario, the Issue Tracker Administrator has to use some third party 

tool, such as FMS Total Visual Agent, to back up Jet databases. This is ideal 

for 24 hour a day operations. 

Steps: 

1. Run the third party tool for backing up live Jet databases. 

2. Backup the Issue Tracker Server folder and all the files inside with the 

exception of the AccessRT folder, which contains the setup program for 

the Microsoft Access Runtime. 

Note: If you have any Issue Tracker projects in a folder outside the Issue 

Tracker Server folder, remember to back up those files as well. 

 

How to Back Up a Complete Issue Tracker Server 

In some cases, you may want to keep a complete copy of the Issue Tracker 

Server and not only the data (typically contained in SQL Server databases). 

This complete backup of the system could be used for cloning a server or for 

disaster recovery, which is particularly useful if a system has power 

customizations.  

In order to do a complete backup of the system: 

1. Back up the SQL Server databases 

As described previously. 

2. Back up System Data not in SQL Server databases (regular files): 

You do not need to do this type of backup frequently as these files rarely 

change.  

Ensure the files are not in use: 

 Unload the Issue Tracker Web virtual directories from the Internet 

Services Manager 

- or - 

If there are no other applications affected, stop the World Wide Web 

service from the Services Manager. 

 Stop the Issue Tracker services from the Services Manager. 

 Close any running instances of Issue Tracker Admin and the Web 

View Editor.   

TIP: you can log off users through the Logons Editor in Issue Tracker Admin. 
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3. Backup the Issue Tracker Server folder and all the files inside with 

the exception of: 

 the AccessRT folder, which contains the setup program for the 

Microsoft Access Runtime 

 *.mdf and *.ldf files, which are the physical files of SQL Server 

databases and should be backed up or synchronized as mentioned in 

the previous section 

You can do this task by using any standard backup tool in the market, such 

as Backup Exec, Backup NOW!, or some Computer Associates tools. 

Note: If you have any Issue Tracker projects in folders outside the Issue 

Tracker Server folder, remember to back up those files as well. 

4. Back up the MetaQuest Common Files: 

You do not need to do this type of backup frequently as these files rarely 

change.  

Back up the complete folder: 

  <SystemDrive>:\Program Files\Common Files\MetaQuest 

This folder contains dlls and binary files needed to run the Issue Tracker 

Server. 

 

5. Back up the Issue Tracker Tools: 

You do not need to do this type of backup frequently as these files rarely 

change.  

Back up the complete IssueTrackerTools folder, which is located by default in: 

 <SystemDrive>:\Program Files\IssueTrackerTools 

This folder contains customized files needed to run administrator tools and 

programs like the Issue Tracker Admin and the Web view Editor. 
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Creating Projects 

A Project defines everything that you see in a view: the fields, queries, 

reports, sorts, and layouts. 

We recommend that you don’t edit the default Projects (such as HelpDesk) 

shipped with Vector Issue Tracker. Instead, create a new Project based on 

one of the default Projects, and use this new Project as your starting point. 

How Many Projects Do You Need?  

Each Vector Issue Tracker Project has its own issue database and definition 

database.  

For example, if you want to record software, hardware, and support issues in 

separate databases, you can create three separate Projects. Separate 

Projects mean smaller databases and better performance. It also means you 

can customize fields, queries, sorts, layouts, and reports on a Project-by-

Project basis. For example, you don’t need a field to specify the issue type 

(software, hardware, or support), and you don’t need separate queries for 

each issue type.  

However, tracking issues in separate Projects has some disadvantages:  

 You cannot generate reports across all Projects. 

 You cannot create a single view that covers all Projects. 

 If a help desk analyst works on all three types of issues, separate 

Projects may be inefficient and time-consuming. 

Choosing a Base Project  

A base Project serves as a starting point for a new Project. The new Project 

inherits the fields defined in the base Project, and can inherit the styles 

(queries, reports, sorts, layouts, and notifications) as well.  

Vector Issue Tracker includes two pre-defined Projects you can use as the 

base Project. Before choosing a base Project, you should familiarize yourself 

with the fields in each Project, and understand what you can and cannot do 

when customizing fields.  

HelpDesk: Designed for use by support departments and help desks, the 

HelpDesk Project allows you to record and track issues reported by 

employees. HelpDesk includes over 60 fields, along with a complete set of 

reports, queries, sorts, layouts, and notifications based on those fields.  
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Some default fields cannot be deleted, and these take up space in your 

database even if you don’t use them. Before deleting a field, you must first 

remove it from any report, query, sort, layout, or notification. Deleting unused 

fields helps minimize the size of your database.  

Timesheet: This project contains the elements required for recording and 

analyzing the time each employee has spent on the Projects in your Issue 

Tracker installation.  

Exercise: Creating a Project 

1 Start Issue Tracker Admin and log on as admin (password = 

admin). 

2 In the File menu, select New Project.  

3 In the Project Name field, type a name for the Project.  

4 To choose a template for the new Project, click HelpDesk in the 

Base Project list. 

A new Project always has the same fields as the base Project.  

5 In the Groups Allowed to Open Project list, select <All> to 

allow all users to open the Project.  

To log on to a view of a Project, users must belong to a group that is 
allowed to open the Project.  

6 Click Copy From the Base Project to copy the styles (reports, 

queries, sorts, and layouts) and notifications from the base 
Project. 

7 By default, a new Project does not include any issues in its 

database. To copy the sample issues from the base Project, 
select the Copy issues and revision history from base 
project check box.  

You can delete the issues later by choosing Delete Issues in the 
Project menu. 
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Creating New Fields 

Fields enable you to extend your Project database to hold information that is 

specific to your organization. Using the Field Editor in Web Admin, you can 

edit and add fields to your help desk Project. The general procedure for 

adding a new field is: 

1 Create the new field: 

a Specify the label (caption) for the field. 

b Select a tab for the field. 

c Choose the type of field: 

 Currency, Date, Time, Number, or Text 

 Memo (multi-line text field) 

 Multiple Choice or Single Choice list 

 Yes/No (check box) 

d Specify the size of the field, whether it is required or 
enabled (disabled fields are read-only), and whether or 
not to keep a revision history for the field. 

2 Update existing queries, sorts, layouts, and reports to include 

the new field, or define new queries, sorts, layouts, and reports 
for the new field. 

For example, you may want to add the new field to the Current Issues 
– Detailed and Notification – Detailed Record reports. Vector Issue 
Tracker uses Current Issues – Detailed to format the output of the 
Print button in a view, and Notification – Detailed Record to format 
e-mail notifications. 

3 Use the Web View Editor to add the field to your views, and 

regenerate the views. 

4 Test the new field by logging on to Vector Issue Tracker and 

opening a view that contains the field. 
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Exercise: Creating a New Field 

This exercise guides you through the process of adding a new field to your 
Project. The field is a single-choice list that indicates whether the user reporting 
the problem has read an internal document that describes how to report 
problems to the IT Department. 

1 Click the Windows Start button, and select Programs, Vector, 

Issue Tracker, Issue Tracker Admin. 

2 Log on as admin (password = admin). 

3 In the Projects list, select HelpDesk. 

4 In the Project menu, select Field Editor. 

5 Click New Field  and type hdmemorandum as the name of 

the new field. 

 

6 In the Destination Tab list, select Overview to display the 

new field on the Overview tab, which is the first tab to appear 
in a view. 

7 In the Field Caption field, type Read the Help request 

memorandum?. This text appears beside the field in a view. 

8 In the Type list of the Data area, click Single Choice. 

9 Click the  button beside the Table Containing Choices list. 

The Choice Editor is displayed.  

The Choice Editor enables you to create and edit the database tables that 
store the choices for single and multi-choice lists. You can also edit the 
choice tables from Issue Tracker Web Admin. 

10 Click New Table  and type a name for the choice table.  

 

Click OK to create the table. 
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11 In the Field Value column, type the possible choices for the list: 

 Has read 

 Has received, but not read 

 Has not received 

 Just joined company 

After you type one choice, press the Tab key to move to the 
next row. 

12 Click Close to save your changes. 

13 In the Table Containing Choices list, select the table you 

created. 

14 In the Field Is area, select the Required check box. This forces 
users to complete the field they can save an issue. 

15 Click Apply. When Issue Tracker Admin warns you that it will 

log off users, click OK. 
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About Web Views 

What is a Web View?  

Web views are different views of a Vector Issue Tracker project. Each Web 

view of a project can display different issues and different fields. 

You use the Web View Editor to create, edit, and generate Web views.  

Types of Views 

The Web View Editor can generate different types of view: 

Normal Views allow users to submit and update issues. 

Read-only Views allow users to review their existing issues, but not to edit 

them or submit new issues. 

Submit-only Views allow users to submit issues from their Web browsers. 

Submit-only views can include all fields or just the fields needed to submit a 

new issue. For example, to submit a new issue, customers don't need to see 

the fields used by help desk staff. 

Knowledgebase Views allow users to search all issues in a project database 

by keyword, by title or by identification number. They include simplified 

layouts, enhanced lookup facilities and special features that enable users to 

look for answers and articles that are already form part of a project database. 

Self-Service Views are a type of Web view to be used by either internal or 
external Issue Tracker users to enter issues and be able to view (and possibly 
edit) the issues they have submitted. You can choose to allow them to edit 
certain fields in issues that they have submitted (for example, the Description 
field); or allow them to edit fields that were left empty when they submitted the 
issue; or simply view their submitted issues in a read-only format. 
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Creating Web Views  

To create a new Web view, you must run the Web View Editor on the Web 

server. Web View Editors installed on other computers can only edit and 

regenerate existing Web views.  

You can either create a new, blank Web view or you can copy an existing 

web view. Copying allows you to reuse all the settings in the existing Web 

view. For example, when you copy a Web view, all the field attribute settings 

are copied.  

Exercise: Create a new Web view  

1 Run the Web View Editor on the Web server 

To start the Web View Editor from Issue Tracker Admin:  

On the Tools menu, click Web, then click Web View Editor. 

The Tools > Web > Web View Editor command is also available when the 
Web View editor is installed on the same computer where you are running 
Issue Tracker Admin.  

To start the Web View Editor from the Start menu:  

Click Start > Programs > Vector > Issue Tracker > Web View Editor. 

2 Log on as admin (password = admin). 

3 Click New View , type the name of the Web view, and click OK. 

4 In the Project Name list, click a project. 

5 In the View Type list, click the type of view you want to generate. 

6 Set the groups allowed to open for the view.  

7 Set the Web view attributes.  

8 Export fields to the Web view.  

9 Export queries to the Web view. 

10 Click  to save your settings and generate the Web view. 

Notes 

    To log on to the Web view, click . 

    Click  to save your settings without generating the Web view. 

Groups Allowed to Open the View 

The Web View Editor enables you to control access to the view. Users who 

do not belong to one of the groups allowed to open the view do not see it 

when they log on. 
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To select the groups that are allowed to access the view, click the  button 

to open the View Permissions dialog. 

In the Groups box, click the groups you want to be able to access the Web 

view. 

If you allow the Users group to open the Web view, then all users can open 

the Web view.  

The Groups box lists the groups that are allowed to open the project (as 

specified in Issue Tracker Admin).  
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Web View Attributes 

To set Web view attributes 

1 In the shortcut bar, click  Web View. 

2 Click  (beside Attributes) to open the Web View Attributes dialog: 

 

 Description 

This is the description of the Web view. It is displayed in the list of Web views that 

appears when a user logs on. The default description is the Project / View name. To 

include the project and view names in the description, use the macros 

<ProjectName> and <ViewName>.  

If you change this attribute, you must regenerate the Web view.  

 

 Display All Read-Only Fields As Text  

Read-only fields can be displayed as text (select Yes) or as disabled controls (select 

No). In read-only and knowledge base Web views, all fields are read-only. In normal, 

self-service and submit-only Web views, read-only fields have been disabled through 

the Field editor.  

If you change this attribute, you must regenerate the Web view.  

 

 Issues per Page 

This is the number of issues to show per page in the Summary List.  

 

 Timeout 

The number of minutes of inactivity before the browser session times out and the user 

is logged off.  

 

 Load Issues Not In Query 

If set to Yes, users can load any issue that they want by typing the issue number in 

the Issue box of the Web view. If set to No, users can load only the issues shown in 

the Summary List.  
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Adding Fields to Views 

New fields are not automatically included in your views. To include a new field 

in a view, you must edit the view definition and regenerate the view with the 

Web View Editor. 

Exercise: Adding a Field to a View 

1 In the Project / View list, select web view you created in the 
previous exercise. 

2 In the shortcut bar, click  Fields. 

3 If you do not see the hdmemorandum field in the Available 

box, click Overview in the Tab list. 

Click the hdmemorandum field, then click  to move the field to the 

Export To View list for the Overview tab.  

4 The list order determines the order in which the fields are 

displayed in the view. In the Export to View list, select the 

hdmemorandum field and use the  button to move the field 

to the top of the list. 

5 Click  to generate the view (and save your changes). 

It can take several minutes to generate a view. 

6 If you want to log off all users, click Yes. This prevents users 
who are currently logged on from continuing to work with a 
version of the view that does not include the hdmemorandum 

field. A message is displayed to users who are logged on, and 
users who try to log on telling them that the administrator is 
shutting down the system. 

If you want to allow users to remain logged on, click No. The field is 
displayed when users next log on. 

7 When the view is generated, click Test  to log on to the view 

and check your changes. 

 

You can also access the view using the URL displayed in the Web View 
Editor. 

8 Check the hdmemorandum choice list is displayed in the 

Overview tab. The Dark Red color of the label indicates that 
the field is required. 
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Web View Field Attributes 

The fields on a Web view are arranged in a two-column layout inside an 

HTML table. The order of the fields is determined by the order in which they 

are listed in the Export to View list.  

The appearance and layout of the fields can be customized through field 

attributes, which control options such as alignment, width, and height. 

The following table lists the attributes:  

Name Description 

Alignment Aligns a field. Possible values are Left, Right, or Center. 

Automatically 

Update List (Multi-

Choice) 

If Yes, the choice list is updated each time a user logs on to the Web view. 

If No, the choice list is updated only when the Web view is regenerated. 

 

To turn on the automatic update of choice lists, you must regenerate the 

view after you set this attribute to Yes. 

Caption Label text for a field. 

Column Span Set Column Span to 1 to have the field span one column of the page.  

Set Column Span to 2 to have the field span both columns of the page. To 

adjust the size of the field, set the CSS Class to either MemoFieldWidth (for 

text boxes and memo fields that are two columns wide) or 

SpanTwoWidthOne (for fields that are one column wide but are still alone 

on a line). 

CSS Class Name of a style in the Web view stylesheet (CensusMain.css). 

Display Read-Only 

Field As Text 

Default = use the value of the Display All Read-Only Fields As Text attribute 

Yes = if field is read-only, display it as text 

No = if field is read-only, display it as a disabled control 

Editor Choose the editor type for the memo field. 

Height Number of lines in a multi-line text box. 

Html code after 

control 

HTML inserted after the control in the generated HTML page. 

Html code before 

control 

HTML inserted before the control in the generated HTML page. 

Link to user details Select Yes to show the details of the selected user or contact when clicking 

on the value. 

Number of 

Characters 

Maximum number of characters per line in the text box. 

Number of Visible 

Items 

Number of items visible in the list box. Users can always see items that are 

outside the visible window by scrolling the list box. 

Select from dialog Select Yes to display the choices in a pop-up dialog, select No to use a 

drop-down list. When the choice list has too many items, it becomes difficult 

to select a value using a drop-down list and it can also slow performance. 

The pop-up dialog also allows searching and sorting the choices. 
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Name Description 

Show Selected 

Items In Text Box 

Shows a comma-separated list of the selected items in a text box above the 

list. 

 

This helps users see what items are selected. 

Show Selected 

Items In Tooltip 

Shows a comma-separated list of the selected items in a tooltip. 

 

This helps users see what items are selected. 

URL Address of a resource on the Web or elsewhere on the Internet. 

Can be an absolute or relative address. 

URL Button CSS Base name for the CSS class of the button that connects to the URL. 

Type 'URLButton' or 'RemoteControl' to use the default CSS classes. 

The CSS class name is formed by adding 'State1' to the base name (for 

example, 'URLButtonState1'). 

Vertical Alignment Sets the vertical positioning of a field. Possible values are Top, Middle, and 

Bottom. 

Visible If No, the field is hidden. 

Width (Char) Width of the field (in characters for text boxes, in pixels for list boxes). 

 

Using Field Variables  

Field variables allow you to insert the name, value, or id of a field into an 

attribute. The field variables are particularly useful with the Html code after 

control and URL attributes. 

Variable Inserts 

%fieldvalue% The current value of the field. For choice lists, %fieldvalue% is the ID of the 

choice. 

%fieldname% The name assigned to the input control (for example, cbo_18_cboPriority). 

%fieldid% The numeric ID of the field (this is the nID of the field in tblDtsFIelds). 
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Exercise: Hiding a Field 

1 Log in to the Web View Editor 

2 Choose a Web view 

3 Select a field that is not required and set the Visible field 
attribute to No. 

4 Generate the Web view 

5 Log in to the Web view and ensure the field you hid is not 

visible. 

 

Exercise: Changing the Caption of a Field 

1 Log in to the Web View Editor 

2 Choose a Web view 

3 Select a field set the Caption field attribute to something 

different from the name of the field. 

4 Generate the Web view 

5 Log in to the Web view and ensure the field has the new caption.
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Adding URL Buttons  

URL buttons open a new browser window and load the document specified by 

the URL attribute. A URL button is associated with a field, and can use the 

field value as part of the URL.  

For example, suppose you wanted to record the ID number of a Microsoft KB 

article that explains how to resolve a problem.  

Exercise: Add a URL to a Field 

1 Use the Field Editor to create a text field called KB Article. 

2 Log in to the Web View Editor 

3 Export the new field to a Web view. 

4 Set the URL field attribute to: 

http://support.microsoft.com/default.aspx?scid=kb;en-
us;%fieldvalue% 

Note: %fieldvalue% is a placeholder for the KB article ID 
number entered in the field. 

5 Set the URL Button CSS attribute to: URLButton  

6 Generate the view 

7 Log in to the Web view 

8 Save a value in the KB Article field. 

9 Click on the button beside the field to ensure that the KB Article 

loads correctly. 

The URL Button CSS attribute identifies the CSS classes used for the 

button. Vector Issue Tracker includes several different URL button classes 

you can use:  

  URLButton 

 

  MailToButton 

 

 RemoteControl 

 

Adding Timestamping  
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Changes to a memo field can be time-stamped. For example, you can time-

stamp the changes, comments, notes, and follow-ups that are added to an 

issue description over time.  

Timestamping requires two memo fields, one for input and one for storing the 

timestamped log. When an issue is saved, the Web view automatically copies 

the contents of the input field to the log field.  

Exercise: Creating a Timestamp Field 

1 Use the Field Editor to create a memo field for input of new 

data, and a field for displaying the timestamped log. For the 
input field, clear the Show in Choice Lists and Maintain 
Revision History check boxes.  

2 Find the internal name of the timestamp log field. The internal 

name looks like mem_FieldID_mem_FieldID_FieldName.  

Open the project definitions database and look in the 
tblDtsFields table. The field name is composed from the values 
in the nID and tBoundControlName fields:  

mem_<nID>_<tBoundControlName>  

The tBoundControlName field includes a repeat of the 
mem_<nID> string. That is why the string appears twice in the 
name.  

3 Export the two fields with the Web View Editor and set their 

HTML code after control attributes: 

 For the input field, enter this HTML code (as a single line of 
text): 

<script type='text/javascript'>document.write( 

parent.objCustomCode.getCodeAfterField( '%fieldname%', 

'<timestamp-log-field-name>' ) ) </script>  

<timestamp-log-field-name> is the field name you found in the 
previous step. Note that the javascript is case sensitive. 

 For the timestamp log field, enter this HTML code (as a 
single line of text): 

<script type='text/javascript'>document.write( 

parent.objCustomCode.getCodeAfterField('%fieldname%','' ) 

)</script>  
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Remote Control Integration 

To start a remote control session, all a help desk analyst has to do is type a 

computer name in a field and click the Remote Control button  beside the 

field. The default HelpDesk Project includes a Computer Name field with a 

Remote Control button: 

 

The Remote Control button connects to the specified computer and starts a 

PC-Duo ActiveX Remote Control session. The remote control session runs in 

a browser window, and does not require the PC-Duo Control to be installed 

on the local computer. 

The requirements for remote control are: 

 The view must be running in Internet Explorer, because the Remote 

Control button loads a page that contains an ActiveX control (ActiveX 

is supported only on Internet Explorer). The ActiveX control allows 

the help desk user to watch, share, or control the remote computer. 

 PC-Duo Client must be installed on the remote computer, and the 

Client cannot use its license key serial number as a security key. 
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Remote Control Interface 

The interface buttons cannot be interacted with while a connection is in 

progress, only when it is completed. Once it is available, it offers numerous 

ways to interact with the client (host) machine.  

The interface is better explained when split into three different sections:  

 

Controls 

 

The first three buttons allow you to choose how to interact with the host 

desktop. 

Watch mode 

This mode allows you to view the host machine; however, your 

keyboard and mouse will not affect it. 

Control mode 

This mode allows you to interact with the desktop normally – mouse 

and keyboard are fully functional.  

When you activate this mode, other users that are connected with 

Remote Control are forced into Watch mode. However, if someone is 

using the physical host machine, they can still control the mouse and 

keyboard whenever desired. 

Transfer Files 

Clicking this button will replace the viewer window with a “File 

Transfer” screen that allows you to move files to and from the host 

machine. 
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Actions 

 

 

This section of the interface allows you to perform certain actions once 

connected to the host. 

Get Clipboard 

Remote Control will retrieve the clipboard on the host machine, and 

copy it to your machine. 

Send Clipboard 

Remote Control will take your clipboard, and copy it to the host 

machine. 

Send Ctrl-Alt-Del 

This is the equivalent of pressing the “CTRL-ALT-DEL” key 

combination on the physical host machine. 

Options 

 

 

Scale to Fit 

This option, if enabled, will scale the host screen so that it fits the 

current viewer window. If disabled, the host screen will be displayed 

in its regular proportions. 

Suppress Keyboard & Mouse 

This option prevents the host machine from being able to use the 

mouse and keyboard. This option only works if you are in “Control” 

mode. The host must also be configured to support this feature. 

Blank Host Screen 

The “Blank Host Screen” option allows you to prevent the host from 

seeing the desktop. While enabled, the host will just see a black 

screen. The host must be configured to support this feature. 
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Exercise: Adding a Remote Control Button to a Field 

1 Log on to the Web View Editor. 

2 In the shortcut bar, click the Remote Control  button. 

3 In the Available Fields list, expand the tab that contains the 
field. 

4 If you do not see the field, select the Show All check box to 

show all available fields. 

5 Select the Can Connect check box for the field.  

This automatically sets the URL field attribute to 

../../RC/rcviewer.asp?Client=%fieldvalue% 

The first part of the URL (../../RC/rcviewer.asp) is the Remote Control 
URL, which points to this file: 

IssueTrackerServer\CensusWeb\Views\CensusWebVD\RC\rcviewer.asp 

The RCviewer.asp file is installed with PC-Duo Issue Tracker. You can 
customize this file to change the default remote control settings. For 
example, you can specify the security key used to access clients, and 
enable encryption or compression. 

The second part of the URL is a query string that identifies the computer 
to control. When a user clicks the Remote Control button, 
%fieldvalue% is replaced with the current contents of the field. 

6 Notice the Gateway List textbox. Here you can specify which 
PC-Duo Gateways to use whenever Remote Control tries to 
connect to a client. You can specify multiple gateways here, 
delimited by semi-colon: “GatewayA;GatewayC;GatewayB”. The 
order is significant – the first Gateway that appears is the first 
gateway that will be consider. In this example, if Gateway A 

works immediately, then the other gateways aren’t used. If 
Gateway A fails, then the system will automatically try with 
Gateway C, and so on. If all gateways fail, or no gateways are 
specified, Remote Control will try to connect using Peer-to-Peer 
mode. 

7 Click  to generate the view. 

8 When the view is generated, click Test  to log on to the view. 

9 Create a new issue and try out the new Remote Control 
button. 
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Editing Choice Lists 

Vector Issue Tracker administrators are often asked to update choice lists. 

For example, when you want to start tracking problems with a new software 

application, you need to add a new choice to the Problem Area list. This 

enables users to accurately categorize problems by the software or hardware 

that seems to be causing the problems. 

Exercise: Exercise: Add Choices to a Choice List 

This exercise demonstrates how to add a new application, called Auto-Draw, to 
the Problem Area list, so the help desk can handle any problems related to it.  

1 Log on to Issue Tracker Web Admin as admin (password = 

admin). 

2 Click the Choices tab. In the Project list, select HelpDesk. 

3 In the Choice List list, select Problem Area. The Problem Area 

choices are displayed. 

4 In the Choices section, click Add choice . 

5 In the Add Choice dialog, type Apps – Auto-Draw, and click 

OK.  

The Apps – Auto-Draw choice is added to the list.  

6 Click the Update Now button to add the value to all Web views 

that have this choice list without regenerating the Web view. 

7 Log off Issue Tracker Web Admin. 

8 Log on to the HelpDesk / HelpDesk view. 

9 Create a new issue and select Apps – Auto-Draw as the 

problem area. 
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Global Choice Lists 

Unlike Choice lists, which are only available within one Project, Global Choice 

Lists are shared by all Projects. After creating the Global Choice list, you can 

use the Field Editor in Issue Tracker Admin to associate the choice list with a 

field. 

Exercise: Creating a Global Choice List 

1 Open Vector Issue Tracker Web Admin from Start, All 
Programs, Vector, Issue Tracker, Issue Tracker Web 
Admin. 

2 Select the Choices tab within Issue Tracker Web Admin. 

3 In the Project list, click Global Choice Lists. 

4 Click  to create a new choice list. 

Use the  button to copy an existing Choice list to a new list.  

5 When prompted, call your new choice list tblPrinters and name 

the caption as Printers. 

6 In the Choices section, click Add Choice . 

7 In the Add Choice dialog, type HP LaserJet 8000, and click 
OK. 

The HP LaserJet 8000 choice is added to the list. 

8 Repeat steps 5 and 6 to add more printers to the Choice list. 

You have now created a Global Choice list called Printers. This list can be 
used in all Projects available to you in your Issue Tracker installation. 

To add this Choice List to your views, create a new field for your Choice 

List.  You must regenerate the Web view to display your Choice list. 
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Admin Options 

To use Issue Tracker most effectively, you should configure the options. To 

do this, start Issue Tracker Admin and, in the Tools menu, select Options. 

The following table lists the options: 

 

Name Description 

Monitor Interval How often (in seconds) a Web view should check for system 

messages (such as shutdown and timeout messages). 

 

The default interval is 60 seconds. If the interval is too large, 

the administrator will have to wait a long time when logging off 

users. 

Send immediate shutdown 

message 

Send an immediate shutdown message to Web views when 

users are logged off (in addition to the standard message). 

Enable backups Back up files when the field definitions are changed. 

SMTP server Valid name or IP address of an SMTP server (if using SMTP 

as the mail system). 

Always verify locked databases When logging off users, always check if the users have a lock 

on a database. 

SLA Rules Evaluation Interval Evaluate Service Level Agreement rules at the specified 

interval (in minutes). 

Mail Integration Check Email 

Interval 

Check for new emails interval for Mail Integrations 

Server Mail Sender Name of sender for SMTP e-mail. Some SMTP mail servers 

require the sender name to be a valid e-mail address. 

Server Mail Interval Send e-mail notifications at the specified interval (in minutes). 

Standard Report Engine Specifies the default report engine used to display listing 

reports, format notifications, and print issues. To use Crystal 

Reports, you need a Report Creation API license on the Web 

server. 

Custom Report Engine Specifies the default report engine used to display custom 

reports. The HTML report engine displays custom reports as 

standard listing reports. 

Server SMTP Port The port for the SMTP server. 

Maximum Notification Retries The maximum number of retries for e-mail notifications. Once 

surpassed, the notification will be sent to the address specified 

in the Send Invalid Notifications To option. 
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Send Invalid Notifications To If the Maximum Notification Retries is surpassed, the 

notification will be sent to this address. If there is no address 

specified, the notification service will continue trying to send to 

the original recipient. 

Server SMTP User Name The user name for logging into the SMTP server. Use this only 

if your SMTP server requires authentication. 

Server SMTP Password The password for logging into the SMTP server. Use this only 

if your SMTP server requires authentication. 

Request Read Receipt Request a read receipt when sending out e-mails from the web 

views. 

Delete Attachments Web view users can upload file attachments to the Web 

server. 

To delete uploaded file attachments when they are removed 

from issues, set Delete Attachments to Yes. 

 

We recommend that you leave Delete Attachments set to No. 

Password Complexity 

Requirements 

Specifies the requirements for passwords that are set for 

users. The default requirements for the "Allow complex 

passwords only" option are: exactly 8 characters long, with at 

least 1 lowercase letter, 1 uppercase letter and 1 number. 

Password Expiration How often (in days) the user's password should expire. Applies 

to Issue Tracker Authentication user accounts when logging 

into the Web views. New users will need to set their password 

the first time they log in. Enter 0 to disable this option. 

 

Exercise: Setting Options 

1 Check that the Standard Report Engine option is set to HTML. 

2 Log in to a Web view and load a Listing report. 

3 Notice how the report looks. 

4 Log off from the Web view. 

5 Change the Standard Report Engine to Crystal Reports 9. 

6 Log in to a Web view and load a Listing report. 

7 Notice how the report looks. What is different from before? 
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Building Queries 

Vector Issue Tracker ships with over twenty predefined queries, such as All 

Open Issues, My Open Issues, and My In Progress Issues, which enable 

you to view and work with selected issues from a Project. However, you can 

also add your own queries to the list to create customized issue lists for your 

own specific uses. The following exercise guides you through creating a 

query that finds all printer-related issues. 

Exercise: Creating a Query 

1 Start Issue Tracker Admin and log on as admin (password = 

admin). 

2 In the Project list, select a Project. The new query is added to 

this Project. 

3 In the Project menu, select Query Editor. 

4 In the Query Editor, click the New Query  button. Name the 

query All Printer Related Issues and click OK. 

5 To create a query that finds all issues logged against the 

System – Printing area: 

a In the Field Name list, select Problem Area. 

b In the Test field, click =. 

c In the Value list, select System – Printing. 

 

6 Click Apply, and then click Close. 
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Exercise: Exporting a Query 

To make the new query available in your view, you must regenerate the view. 

1 Start the Web View Editor and log on as admin (password = 

admin). 

2 In the Project / View list, select HelpDesk/HelpDesk. 

3 In the shortcut bar, click  Queries. 

4 In the Available list, click the All Printer Related Issues 
query. Click  to move the query to the Export To View list. 

5 Click  to generate the view (and save your changes). 

6 Click No to generate the view without logging off users. 

7 When the view is generated, click Test  to log on to the view 

and test your changes. 

8 Click the Query  button, and run All Printer Related 
Issues to list all printer-related issues in the Summary list. 

 

Exercise: Creating a Query with multiple conditions 

1 Click the Windows Start button, and select Programs, Vector, 

Issue Tracker, Issue Tracker Admin. 

2 Log on as admin (password = admin). 

3 In the Projects list, select HelpDesk. 

4 Click Project > Query Editor. 

5 Click the New Query  button.  

6 As a query name, enter Issues for Employee Originating from 

Web or E-mail. 

7 Click OK. 

 

Adding a query condition: Contact = Employee And 

8 Click the Field Name cell in the first Query row, and select the 

value Contact. 

9 In the Test cell, select =. 

10 In the Value cell, select Employee. 

11 In the Operator cell, select And. 
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Adding a query condition: Source = Web Or 

12 Click the Field Name cell in the second Query row, and select 

the value Source. 

13 In the Test cell, select =. 

14 In the Value cell, select Web. 

15 In the Operator cell, select Or. 

 

Adding a query condition: Source = E-mail 

16 Click the Field Name cell in the third Query row, and select the 

value Source. 

17 In the Test cell, select =. 

18 In the Value cell, select E-mail. 

19 Select the row you created in steps 16-18 and click the Add () 

 button. 

20 Click Apply. 

21 Click Close. 

The query, at this point, should look like this: 

 

To test it, export the query using Web View Editor, and then execute it in the 
HelpDesk view. The issues returned should all have the Contact Employee, and 
a Source value of Web, or E-mail. Check a few issues to make sure this is the 

case. 
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Exercise: Creating a Query with multiple conditions and the use of macros. 
 

1 Click the Windows Start button, and select Programs, Vector, 
Issue Tracker, Issue Tracker Admin. 

2 Log on as admin (password = admin). 

3 In the Projects list, select HelpDesk. 

4 Click Project > Query Editor. 

5 Click the New Query  button.  

6 As a query name, enter High Priority E-mail/Software Issues 
Closed Before Today 

7 Click OK. 

 

Adding a query condition: Closed Date <> <Today> And 

8 Click the Field Name cell in the first Query row, and select the 

value Closed Date. 

9 In the Test cell, select <>, which means “not equal to”. 

10 In the Value cell, select <Today>. The <Today> macro will 
automatically be resolved to the current day, whenever you run 
the query. 

11 In the Operator cell, select And. 

 

Adding a query condition: State = Closed And 

12 Click the Field Name cell in the second Query row, and select 

the value State. 

13 In the Test cell, select =. 

14 In the Value cell, select Closed. 

15 In the Operator cell, select And. 

 

Adding a query condition: Priority = High Or 

16 Click the Field Name cell in the third Query row, and select the 

value Priority. 

17 In the Test cell, select =. 

18 In the Value cell, select High. 

 

Adding a query condition: Priority = Highest And 
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19 Click the Field Name cell in the fourth Query row, and select 

the value Priority. 

20 In the Test cell, select =. 

21 In the Value cell, select Highest. 

22 Select the row you created in steps 19-21 and click the Add () 

 button. 

 

Adding a query condition: Service Type = E-mail Or 

23 Click the Field Name cell in the fifth Query row, and select the 

value Service Type. 

24 In the Test cell, select =. 

25 In the Value cell, select E-mail. 

 

Adding a query condition: Service Type = Software 

26 Click the Field Name cell in the sixth Query row, and select the 

value Service Type. 

27 In the Test cell, select =. 

28 In the Value cell, select Software. 

29 Select the row you created in steps 26-28 and click the Add () 

 button. 

30 Click Apply. 

31 Click Close. 

The query, at this point, should look like this: 

 

 

To test it, export the query using Web View Editor, and then execute it in the 
HelpDesk view. Verify that the conditions added in the exercise are reflected in 
the results. 
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Defining Sorts 

Sorts enable you to order the issues listed for a view. There are over 10 pre-

defined sorts available to the Issue Tracker users. You can also add your own 

sorts using the following method. 

Exercise: Creating a Sort 

1 Start Issue Tracker Admin and log on as admin (password = 

admin). 

2 In the Project list, select the Project to which you want to add 

the new sort. 

3 In the Project menu, select Sort Editor. 

If the Sort Editor option is not displayed in the menu, click the  
button or double-click the menu to expand it. 

4 In the Sort Editor, click New Sort . Type Department as 

the name for the sort and click OK. 

 

5 Add a row to the query: 

a In the Field Name list, select Department. 

b In the Sort Order list, select Alphabetic Descending. 

6 Click Apply, then click Close. 

The new sort is available in all views of the Project. 
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Defining Layouts 

Layouts define which fields are displayed in the Summary list. You can add 

your own layouts to the list. The following exercise guides you through 

creating a new layout.  

Exercise: Creating a New Layout 

1 Start Issue Tracker Admin and log on as admin (password = 

admin). 

2 In the Project list, select the Project to which you want to add 

the new layouts. 

3 In the Project menu, select Layout Editor. 

If the Layout Editor option is not displayed in the menu, click the  
button or double-click the menu to expand it. 

4 In the Layout Editor, click New Layout . In the Name field, 

type Contact. 

 

5 Define a layout of contact-related information. For example: 

 

Use the Title field to change the text that appears in the column header. 
The default text is the field name, which, in many cases, is too long. 

6 Click Apply, then click Close. Your new layout is available in all 

views of the Project. 
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Notifications 

You can configure Vector Issue Tracker to automatically generate notification 

messages that inform users of changes to the Issue Tracker database. 

Notifications work by monitoring one or more fields in the database and then 

sending e-mail messages to the contact, the owner, the previous owner, or a 

specific user when a change occurs. 

Notifications are sent using the native e-mail system. They can be used to 

keep users up-to-date with changes to issues avoiding the need to run 

queries, inspect issues, and review revision histories to find out about 

changes. 

Use notifications for changes to fields like Owner, Progress, and Priority. 

Defining too many notifications can overwhelm users with e-mail, and result in 

them missing important notifications  

Editing Notifications 

Use the Notification Editor to define and edit the notifications for your system. 

With it, you can: 

 Specify who you want to receive the notification. Select the names of 

one or more users from the Send Notification to list.  

 Define when you want Vector Issue Tracker to send the notification. 

Click the button beside the When list to define a when condition, which 

is like a query that retrieves updated issues.  

 Specify what you want to include in the notification message. The body 

of a notification message can include information from the Issue 

Record or the Revision History.  

 Describe why the notification was sent. Enter a one-line description in 

the Notification Description field. You can include this description in 

the body of the e-mail message.  

Exercise: Sending a notification when a new issue is submitted. 

1 Click the Windows Start button, and select Programs, Vector, 

Issue Tracker, Issue Tracker Admin. 

2 Log on as admin (password = admin). 

3 In the Projects list, select HelpDesk. 

4 Click Project > Notification Editor. 

5 Click the New Notification  button.  

6 As a notification name, enter New Issue Submitted. 
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7 Click OK. 

8 Click the Send Notification To dropdown, select <Owner>. 

9 Click the […] button next to the When field. 

10 Click the New When  button.  

11 As the when name, write Issue Submitted. 

12 Click OK. 

13 Click the Field Name cell in the first When Condition row, and 

select the value Revision Number. 

14 In the Test cell, select =. 

15 In the Value cell, type 1. 

16 In the Operator cell, select And. 

17 Click the Field Name cell in the second When Condition row, 

and select the value Submitted Date. 

18 In the Test cell, select =. 

19 In the Value cell, select <Today>. 

20 Click Apply. 

21 Click OK. 

22 Click the When dropdown, and select the newly created Issue 

Submitted entry. 

23 Set the Include field to include Notification Description, 
Summary and Detailed. 

24 In the Description field, write A new issue has been submitted. 

25 Click Apply. 

 

Log in, and create a new issue in the Issue Tracker system, and make yourself 
the owner. An e-mail should be sent to the e-mail address associated with your 
user account shortly. 

 

Exercise: Sending a notification when a non-owner updates the issue. 

1 Open the Notification Editor 

2 Click the New Notification  button.  

3 As a notification name, enter Owner Issue Edited. 

4 Click OK. 

5 Click the Send Notification To dropdown, select <Owner>. 
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6 Click the […] button next to the When field. 

7 Click the New When  button.  

8 As the when name, write Non-owner updated the issue. 

9 Click OK. 

10 Click the Field Name cell in the first When Condition row, and 

select the value Revision Number. 

11 In the Test cell, select >. 

12 In the Value cell, type 1. 

13 In the Operator cell, select And. 

14 Click the Field Name cell in the second When Condition row, 

and select the value Owner. 

15 In the Test cell, select <>. 

16 In the Value cell, select <User>. 

17 Click Apply. 

18 Click OK. 

19 Click the When dropdown, and select the newly created Non-

owner updated the issue entry. 

20 Set the Include field to <All>. 

21 In the Description field, write Someone edited your issue – see 

the included revision history changes. 

22 Click Apply. 

 

Log in, and create a new issue in the Issue Tracker system, and make yourself 
the owner. Log in with another user, and then modify your issue. An e-mail 
should be sent to the e-mail address associated with your user account shortly. 

 

Exercise: Sending a notification when VIP issues are updated 

 For this exercise, we’re going to be treating the users “Jean Manager” and 
“Jean Developer” as VIP users. 

1 Open the Notification Editor. 

2 Click the New Notification  button.  

3 As a notification name, enter VIP Update Notification. 

4 Click OK. 

5 Click the Send Notification To dropdown, select <Owner>. 

6 Click the […] button next to the When field. 
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7 Click the New When  button.  

8 As the when name, write VIP user updated highest priority 

issue. 

9 Click OK. 

10 Click the Field Name cell in the first When Condition row, and 

select the value Revision Number. 

11 In the Test cell, select >. 

12 In the Value cell, type 1. 

13 In the Operator cell, select And. 

14 Click the Field Name cell in the second When Condition row, 

and select the value Priority. 

15 In the Test cell, select =. 

16 In the Value cell, select Highest. 

17 In the Operator cell, select And. 

18 Click the Field Name cell in the third When Condition row, 

and select the value Submitter. 

19 In the Test cell, select =. 

20 In the Value cell, select Jean Manager. 

21 In the Operator cell, select Or. 

22 Click the Field Name cell in the fourth When Condition row, 

and select the value Submitter. 

23 In the Test cell, select =. 

24 In the Value cell, select Jean Developer. 

25 Select the row you created in steps 24-26 and click the Add () 

 button. 

26 Click Apply. 

27 Click OK. 

28 Click the When dropdown, and select the newly created VIP 

user updated highest priority issue entry. 

29 Set the Include field is set to <All>. 

30 In the Description field, write A VIP issue has been updated! 

31 Click Apply. 

 

Log in as “Jean Manager” or “Jean Developer” (no password), and create a new issue in the 

Issue Tracker system. Log in as “admin”, and modify this issue to have Priority of Highest, 

and change the Owner to admin. After saving the issue, further edits should trigger the 

notification. 
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Issue Tracker Users and Security 

Issue Tracker Admin and Issue Tracker Web Admin contain several security 

features that control access to Issue Tracker and the information available to 

each type of user. 

Users 

All Issue Tracker users must have a user account, which consists of a user 

name and an optional password. User names and passwords can be unique 

to Issue Tracker, or you can use the accounts defined in your organization’s 

Active Directory or Domain systems. 

Groups 

Groups control access to Issue Tracker features and information. By 

assigning users to groups, you can control: 

 Access to features in the Admin utilities and in the views. 

 Access to Projects. 

 Workflow permissions.  

Use Issue Tracker Admin to create groups, edit group privileges, and assign 

users to groups. Use the Web View Editor to control access to views. 

Contacts 

A contact is a person who reports an issue. A contact does not need to be a 

Vector Issue Tracker user. For example, a guest from another company may 

report an issue with a computer while working on-site. In this case, the guest 

is the contact, and the help desk analyst who enters the report into Issue 

Tracker is the submitter.  

To create and manage a list of contacts, use Issue Tracker Web Admin, or 

the Issue Tracker User Import Manager to import your contacts from your 

Active Directory or Domain. Views can also include a Contact button that 

opens the Contacts Editor. Access to the Contacts Editor from a view is 

controlled by group permissions.  
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Creating and Updating User Accounts 

The following exercise demonstrates how to create an account for a fictional 

user, Bob Sinclair. 

Exercise: Adding new users  

1 Click the Windows Start button, and select Programs, Vector, 

Issue Tracker, Issue Tracker Web Admin. 

or 

Open your browser. In the address field enter 
http://pcname/vitadmin.  

Where pcname is the name of your PC. 

2 Log on as admin (password = admin). 

3 Select the Security tab. 

4 In the Project choice list select HelpDesk. 

 

5 In the Display choice list, select All Users. 

All Users enables you to view all the users associated with the 
HelpDesk Project. Use the Display choices to view the contacts and 
users within the Project and to search for specific names. 

6 Click the Add User  button.  

 

 

7 In the Authenticate With choice list, select Issue Tracker 

Authentication to check the user details against the Issue 
Tracker user database. 
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8 To add a new user, enter their details on the right of the 

browser window. This exercise demonstrates how to create an 
account for Bob Sinclair. 

When creating a new user, Vector Issue Tracker allows Administrators to 
specify a logon name, password, user name, e-mail address and other 
contact details. The fields listed in bold red lettering are required and 
must be completed. 

For this exercise, enter a Logon Name and Password of BSinclair, and 
complete the rest of the details.  

9 Click Apply to create the new user. 

User Category allows Administrators to specify which users are visible 
within a Project. This enables you to restrict the list of users that can be 
seen in each of your Projects while maintaining a single user database. 

 

Exercise: Updating existing users  

1 In the Display choice list, select Names starting with… 

All Users enables you to view all the users associated with the 
HelpDesk Project. Use the Display choices to view the contacts and 
users within the Project and to search for specific names. 

2 Type Bob in the text box and press Enter. 

3 Select the user that you created from the filtered list 

4 Click the Edit button. 

5 Update Bob’s information, changing his phone, address, etc. 

6 Click Apply to update the user. 

 

Note: Use the Edit Logon button instead of the Edit button if you wish to change the Logon 
Name or Password of an existing Issue Tracker user. 
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Changing User Permissions 

When you create new users, they are automatically added to the Users group 

by default. This group has limited permissions and members of the group 

cannot perform administrative tasks. The following exercise shows you how to 

give administrative permissions to a user. 

Exercise: Changing User Permissions 

1 Click the Windows Start button, and select Programs, Vector, 

Issue Tracker, Issue Tracker Web Admin. 

2 Log on as admin (password = admin). 

3 In the Project list, select HelpDesk. 

4 In the Display list, select All Users.  

5 In the User Name list, select the user account you created in 

the previous exercise.  

To see the permissions granted to members of the Users group, click the 
Groups tab. In the Group Name list, select Users. To maintain 
security, almost all features are disabled for this group. 

6 To give administrative permissions to the new account.  

a Click the Groups  button.  

b In the Select Groups dialog, select Admins.  

c Click OK. 

The account now has administrative privileges. 

7 To see the permissions granted to members of the Admins 

group, click the Groups icon. In the Group Name list, select 
Admins, then click the Features icon.  

All features are enabled for members of the Admins group. 
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Advanced User Concepts 

New User Default Values 

To assist in the creation of new Issue Tracker user accounts and save time, 

administrators can specify default values for fields when a new account is 

created. 

Exercise: Specifying Default User Values 

1 Click the Windows Start button, and select Programs, Vector, 

Issue Tracker, Issue Tracker Web Admin. 

2 Log on as admin (password = admin). 

3 Select the HelpDesk Project from the Project list. 

4 Select to display All Users from the display list. 

5 In the User Name list, select the user account you created in 

the previous exercise.  

6 Click the Make Default  button. 

Issue Tracker remembers the eMail, Company Name, Telephone 

Number, Postal Address, Fax Number, Location, Department and 
User Category.  

Every time you create a new user, all the above fields are populated with 
their default values. You can prevent Issue Tracker from remembering a 
field by clearing it before selecting the Make Default icon.  

7 Click the Add User icon. The fields are populated with the 

default values. 
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Work Teams 

In larger organizations, several people may be assigned to each role within a 

help desk. For example, a business may have staff who are the first point of 

contact for customers, and specialist support teams that handle problems in 

specific areas. Work Teams enable you to group individuals by their 

specialisms and to assign issues to one of these groups without choosing a 

particular individual.   

Issues can be assigned to a Work Team manually through the Assigned 

Work Team field in the Overview tab, or automatically by workflow or Service 

Level Agreements. Team members can then check for issues assigned to 

their Work Team using the My Work Team's Issues query and select an 

issue to work on by assigning a query to themselves. 

Implementing Work Teams 

Four Work Teams are defined for the HelpDesk Project by default. This exercise 
demonstrates how to change and add Work Teams for your own use.  

1 In Issue Tracker Web Admin, click the Choices tab. 

2 In the Project list, select Global Choice Lists. 

3 In the Choice List, select Work Team. The Work Teams for 

your Issue Tracker installation are displayed in the Choices list.  

4 Select Team A and click the Update choice  button. In the 
Update Choice dialog, enter First Line Support and click OK. 
Enter the details of the second-level work teams using the same 
process. Change:  

Team B to Hardware Support 

Team C to Software Support 

Team D to Network Support 

5 Click the Add Choice  button, enter Database Support in 
the Choice field and click OK. 

6 Select the Security tab. Select HelpDesk in the Project list 
and select All Users in the Display list. The list of user names 
is displayed. 

7 Select your entry in the user list, click the Edit  button, and 

select First Line Support in the Work Team list. Click Apply 
to save your changes. 

8 Add at least one user to each of the Work Teams.  



Vector Issue Tracker  Page 62 

Your notes: 

 

 

 

 

 

  Vector Issue Tracker 

Limiting Access to User Lists 

In a multi-Project installation of Vector Issue Tracker, you can limit the list of 

users available in each Project. The visibility of users and contacts can be 

controlled through assigning them to a User Category. The User Categories 

can be edited through Issue Tracker Web Admin. 

Exercise: Editing the List of User Categories 

1 Click the Windows Start button, and select Programs, Vector, 

Issue Tracker, Issue Tracker Web Admin. 

2 Click the Choices tab. 

3 In the Project list, click <Global Choice Lists>. 

4 In the Choice List, click User Category. 

5 In the Choices section, create a new category called Standard 

HelpDesk. 

To add a new User Category, click  and then type the category name. 

To rename a User Category, click the category and then click . 

To delete a User Category, click the category and then click . 

Exercise: Assigning Users and Contacts to Categories 

1 In Issue Tracker Web Admin, click the Security tab. 

2 In the Project list, select the HelpDesk Project. 

3 In the Display list, select to display All Users. 

4 Select the account you created in the previous exercise and then 

click Edit . 

5 In the User Category list, select the Standard HelpDesk 

category we created in the previous exercise. 
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Exercise: Hiding Users in Projects 

1 In Issue Tracker Web Admin, click the Security tab. 

2 In the Project list, select the HelpDesk Project. 

3 Click . 

4 In the Advanced dialog, select the In this Project, only 
display users and contacts in the following categories 
check box, and then select the Standard HelpDesk category. 

Only users in the Standard HelpDesk category are visible in the 
HelpDesk Project. 
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Importing Accounts From Active Directory or Windows Domains 

Issue Tracker user accounts can be synchronized with Active Directory or 

Windows Domain accounts. This enables users to log on to Issue Tracker 

using their standard Windows accounts, and means that Administrators only 

need to manage one user list. 

To ensure that the users details within Issue Tracker are kept up-to-date, you 

can schedule synchronization using the Import User Accounts application, 

which is included as part of the Vector Issue Tracker installation. 

Exercise: Importing User Accounts using the Import Manager 

The Import User Accounts Manager allows you to specify criteria to control user 
imports. Vector Issue Tracker allows users to create multiple rules to allow you 
to import both Issue Tracker users and contacts from different user groups 
within your Windows environment. This exercise demonstrates how to configure 
Issue Tracker to regularly update your user lists. 

1 Select Start, All Programs, Vector, Issue Tracker, Import 

User Accounts to open the Import User Accounts manager. 

2 Logon using admin (Password = admin). 

3 In the Welcome page, click Next. 

4 Click Add to create a new rule. Call your rule Admin Users. 

Click OK. 

5 Click Next. 

6 Select an Active Directory Server or Domain from the list to 
specify where your users are held and click Next to continue.  

If your Active Directory or Windows Domain is not listed, click the browse 

 button, and follow the appropriate instructions: 

To add an Active Directory Server: 

a In the Manage Active Directory Servers and Windows 
Domains dialog, click Add AD.  

b Enter IP address of your Active Directory Server in the Host field. 

c Edit the Port details if this needs to be changed. 

The default port is 389, LDAP over SSL uses port 626 by default. 
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d Enter the Base DN. 

The Base DN is the top level of the LDAP directory tree. For 
example, if you company’s name is “mycompany.local”, the Base 
DN is “dc=mycompany,dc=local”. If you don’t know your Base DN, 

ask your tutor. 

e Enter a Display Name for the Active Directory Server. Vector Issue 
Tracker uses this name to identify the server. 

f Leave the Anonymous Bind check box selected. 

If the Anonymous Bind check box is cleared, you must enter the 
information for authenticating a user when connected to the 
server. 

User DN is the user to authenticate. For example: 

“CN=Administrator,CN=Users,DC=mycompany,DC=local” 

Password is the user’s password. 

g In the Active Directory Logon Name Field, enter the name of 
the Active Directory property that stores the user account name. 
Vector Issue Tracker uses this name to log on. 

h Click Test to test the connection, then click Next. 

To add a Windows Domain: 

a In the Manage Active Directory Servers and Windows 

Domains dialog, click Add Domain.  

b In the Domain list, select the Windows Domain you want to add. 

c If the Computer Name field is blank, type the name of the server 
that is the primary domain controller. The name must be entered 
in UNC format, for example: \\myserver. 

d Click Test to test the connection, then click Next. 

7 In the Import Users dialog select the Administrators group.  

By default, the User Account Import Manager imports all users within the 
Active Directory or Windows Domain you specified. Selected Users 
enables you to choose which users are imported. 

8 The Import Settings dialog specifies the user import settings: 

 Import as Contacts imports members of the specified user 
groups as contacts.  

 Import to Group specifies the Issue Tracker user group you want 
the imported users to join. Select a group from the drop down list. 

 Get E-mail Addresses From imports users’ e-mail details from 
your organization’s Exchange Server. To specify the Exchange 
Server, enter its name or IP Address. 
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 Import any user account that does not already exist in 
Issue Tracker imports any accounts in the specified Active 
Directory or Windows Domain if they don’t already exist. Deselect 
this option to prevent the import manager from creating new 
accounts. 

 Synchronize any user account that already exists in Issue 
Tracker synchronizes all Issue Tracker user accounts with the 
specified Active Directory or Windows Domain. Deselect this option 
to disable any synchronization; any name or e-mail address 

changes must then be performed manually. 

9 To schedule the import and synchronization of user accounts, 
click the Configure button within the Import Settings dialog. 

10 When prompted for a username and password, enter an 

Administrator account for your network, and click OK. 

11 In the Scheduler, specify for the task to run Daily at 03:00 and 

click OK. 

The Advanced Scheduler allows you to be more specific. For example, 
you can specify a time frame when the schedule is valid and configure it 
to repeat every 30 minutes between 9 a.m. and 5 p.m. 

12 Click Finish to import your Admin users into the Issue Tracker 

Project. 

Exercise: Importing Contacts using the Import Manager 

Repeat the previous exercise, importing the user accounts as Issue Tracker 
contacts instead of Issue Tracker users. 
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Managing Logons 

The Issue Tracker Admin utility includes a powerful real-time logon manager. 

As Vector Issue Tracker is Web-based, it is important that you can control 

who is logged on and also that you are able to log off users. The Logons 

Editor enables you to see which users are currently logged on and to log off 

all users. 

Exercise: Using the Logons Editor 

1 Log on to Vector Issue Tracker as demo and open the 
HelpDesk / HelpDesk view. 

2 Start Issue Tracker Admin and log on as admin (password = 

admin). 

3 In the Tools menu, select Logons Editor. 

The Logons Editor shows that admin is logged on to Admin (Issue Tracker Admin) and demo 
is logged on to a view of the HelpDesk Project. 
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Creating Reports 

The Report Editor in Issue Tracker Admin allows you to quickly build and view 

three types of reports:  

 Listing 

 Summary (cross-tab) 

 Time (trend) 

Only Listing reports are exported to views. However, using Crystal Reports 

you can customize a Listing report to include charts, graphics, calculations, 

running totals, and cross-tab tables. In a view, these customized Listing 

reports are available from the Custom tab of the Report Viewer. 

Listing Reports 

Listings extract and present subsets of the information entered in the issue 

records. Listing reports are the only type of report available in views. 

However, using Crystal Reports, you can customize a listing report so that it 

is a cross-tab (Summary) report.  

Listing reports are listings of information entered in the issue records. Use 

listing reports to extract specific information from the issue records. For 

example, you can use them to print a summary of the resolution details for 

each resolved issue, or you print only the record number, owner, and a 

summary of each issue. With listing reports, you choose a set of fields from 

the issue record, and only those fields are included in the report. 

Summary Reports 

Summary reports are like spreadsheets. They give you a numerical break 

down of the state of your Project. For example, use summary reports to 

answer questions, such as: What is the distribution of open issues among 

help desk staff? How many of the open issues are showstoppers? Is there a 

relationship between functional area and issue severity? 

Summary reports are available as text, bar graphs, and pie charts. They are 

available in Issue Tracker Admin. 

Time (Trend) Reports 

Time reports show trends over time. Use time reports to answer questions 

like: What's the issue arrival rate? What's the issue fix rate? How fast are 

severe issues being fixed?  
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Time reports are available as text, line graphs, bar graphs, and pie charts. A 

time report divides the reporting period into intervals of days, weeks, months, 

quarters, or years. The time report then sorts the issues into the time 

intervals, and counts the number of issues in each interval. 

You can control which issues a report counts by choosing values that can be 

entered in an issue record field. The time report counts the number of issues 

with each value. For example, to see the number of Highest and High priority 

issues, you choose these Priority field values. The time report then counts 

the number of Highest and High priority issues in each interval. 

Time reports are available in Issue Tracker Admin. 

Exercise: Create a Summary report 

1 Click the Windows Start button, and select Programs, Vector, 

Issue Tracker, Issue Tracker Admin. 

2 Log on as admin (password = admin). 

3 In the Projects list, select HelpDesk. 

4 Click Project > Report > Editor. 

5 Click the New Report  button.  

6 As a summary name, enter Assigned Open Issues by Severity. 

7 Click OK. 

8 In the Query dropdown, select All Open Issues. 

9 In the Page dropdown, select Open Issues. 

10 Click the Field Name cell in the first Horizontal row, and select 
the value Owner. The rest of the row will be automatically 

populated. 

11 Click the Field Name cell in the first Horizontal row, and select 
the value <Total>. The rest of the row will be automatically 
populated. 

12 In the Vertical section, click the Field Name dropdown, and 

select Severity. 

13 Click the Preview    buttons to make sure the report 
produces the desired results. 

14 Click Apply. 

15 Click Close. 

The report, at this point, should look like this: 
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Exercise: Create a Listing report 

1 Click the Windows Start button, and select Programs, Vector, 
Issue Tracker, Issue Tracker Admin. 

2 Log on as admin (password = admin). 

3 In the Projects list, select HelpDesk. 

4 Click Project > Report > Editor. 

5 Click the New Report  button.  

6 As a summary name, enter Quick View – Issue Description. 

7 Click OK. 

8 In the Query dropdown, select All Issues. 

9 In the Sort dropdown, select Most Recently Updated. 

10 In the radio boxes below the Page field, select Multicolumn. 

11 In the first row’s Field Name column, select Issue. The rest of 

the cells are automatically populated. 

12 Modify the Value Width column so it has a value of 70. 

13 In the second row’s Field Name column, select Summary. The 
rest of the cells are automatically populated. 

14 Modify the Value Width column so it has a value of 70. 

15 In the third row’s Field Name column, select Description Log. 

The rest of the cells are automatically populated. 

16 Modify the Value Width column so it has a value of 70. 
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17 Click the Preview  button to make sure the report produces 
the desired results. 

18 Click Apply. 

The report, at this point, should look like this: 

 

Exercise: Create a Time report 

1 Click the Windows Start button, and select Programs, Vector, 

Issue Tracker, Issue Tracker Admin. 

2 Log on as admin (password = admin). 

3 In the Projects list, select HelpDesk. 

4 Click Project > Report > Editor. 

5 Click the New Report  button.  

6 As a summary name, enter Total Number of Issues by Service 

Type. 

7 In the Query dropdown, select All Issues. 

8 In the Page dropdown, select Total Number of Issues. 

 

In the Time Axis section: 

9 In the Granularity dropdown, select Month. 

10 In the Master Date dropdown, select Submitted Date. 

11 Enable the Cumulative checkbox. 

12 Enable the Show dates with no value checkbox. 

 

In the Time Axis – Range section: 
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13 In the From dropdown, type a date that occurs before all issues 

in the system, for example: 1/1/2011 (works with the default 
HelpDesk issues) 

14 In the When dropdown, select This Year. 

 

In the Field Axis section: 

15 In the Field Name dropdown, select Service Type. The rest of 
this section should be automatically populated. 

16 Enable the Total checkbox. 

17 Click the Preview    buttons to make sure the report 
produces the desired results. 

18 Click Apply. 

19 Click Close. 
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The report, at this point, should look like this: 
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Defining Report Pages  

Report pages define formatting elements common to every page of a report, 

such as headers, footers, titles, and column layout. Report pages also define 

report titles. Pages can be shared by many reports, allowing you to define a 

standard look for all reports generated by Vector Issue Tracker.  

Vector Issue Tracker comes with a set of predefined pages. You can adapt 

these templates to your specific requirements, or define entirely new pages.  

To open the Page Editor:  

On the Tools menu, click Report, then click Page Editor.  

 Choose a page from the Name list. You can then edit, 

delete, or rename the page. 

  To use one page as a starting point for a new page, 

choose a page from the Name list, click Copy, and give 

the new page a name. 

 To create a page from scratch, click New. 

You can use the Page editor to define headers, footers, and titles for your 

reports. In addition to typing and formatting plain text, you can insert 

placeholders for the current date, time, and page number. When you 

generate your report, these placeholders are replaced with values. 

To do this Click 

Insert the current date  

Insert the current time  

Insert the current page number  

Left-align text  

Center text  

Right-align text   

Format text by changing fonts and point sizes, and applying 
bold, italic, or underline styles. 
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Defining Workflow Rules 

Workflow rules allow you to define and enforce an issue handling process. 

Together with e-mail notifications, workflow rules help you automate the 

tracking and management of issues. 

What Can You Do with Workflow Rules? 

When a user selects a choice from a choice list, you can:  

 Select choices in other choice lists. 

 Change the possible choices in other choice lists. 

 

These are the basics of workflow rules. However, this explanation leaves out 

some important details: 

 By default, rules are applied when a user creates, saves, or loads an 

issue. You can also force rules to be evaluated when a user selects a 

choice.  

 Workflow rules can also be based on more complicated conditions. For 

example, a rule may require that certain choices are selected from a 

number of different choice lists, or that the user is a member of a specific 

group, or both. 

What You Should Know about Workflow Rules  

 Rules work with single-choice list fields  

You cannot define rules that apply to any other type of field, including 

multiple-choice list fields.  

 

 Rules are defined per project  

All Web views of a project share the same workflow rules. You cannot disable 

the workflow rules for specific Web views. The rules are either enabled for all 

views or disabled for all views.  

 

 Rules can impact performance  

Defining a large number of rules may impact the performance of Web views.  

Using workflow rules to set default values is a good choice if you have a small 

number of rules and are not limited by resources (server, network, end-user 

computers).  
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 Rules are evaluated when issues are loaded and created  

By default, workflow rules are evaluated when an issue is loaded or created 

(note that when you save an issue it is immediately re-loaded, triggering the 

workflow rules). You can force rules to be evaluated when a user changes the 

value of one of the fields specified in the condition. Evaluating rules on field 

changes has a potentially higher performance cost. However, if you want to 

implement dependent fields, you should evaluate the workflow rule on field 

changes.  

 

 Changes to choice lists can break workflow rules  

If you remove choices from a choice list, or change the meaning of a choice, 

rules that use the choice list may stop working or result in unexpected 

behavior.  

 

 By default, rules apply to all users  

To build group-specific rules, use the macro <User in Group> in your 

conditions.  

 

 The order of rules is important  

Rules are evaluated in the order they are listed in the Workflow Editor. For 

example, in the default workflow, the rule Admins-<Any> is the first rule in the 

list. This ensures that any member of the Admin group can make any change 

to the Progress field.  

If the Admins-<Any> rule is last, then an analyst who is also a member of 

Admins does not have full administrator permissions for changing the 

Progress field. The stricter rules are evaluated first, limiting the changes the 

analyst can make.  



Vector Issue Tracker  Page 77 

 

Your notes: 

 

 

 

 

 

  Vector Issue Tracker 

Creating Rule Templates  

Before you can define any rules, you must create a template. Templates 

define the fields used in rules, and rules provide the values. For example, a 

template might look like this:  

When: 

<User in Group> = _ _ _ _ AND  

Progress = _ _ _ _  

 

The possible values are:  

Progress = _ _ _ _  

 

A template defines what the rules look like, while a rule fills in the _ _ _ _ 

parts with specific values.  

To create a rule template:  

1 Log on to Issue Tracker Web Admin. Click the Workflow tab. In 

the Project list, click a project. 

Workflow rules based on this template apply to all Web views of this 
project.  

2 Click Template and click Add. 

3 In the Add New Template dialog: 

 In the Template Name box, type a name for the template.  

 In the Template Description box, type a short description of the 
template.  

 Select the type of rules you want to define: 

A Dependent Values rule makes the value of one field depend on the 
value of another field. For example, if How Found = Reported by 
Customer then Priority = Highest.  

A Possible Values rule makes the possible values of one field depend on 
the value of another field. For example, if Type = Doc Defect then the 
possible values for Functional Area = Help, Readme, or Manual.  

4 Click OK.  

5 In the list of templates and rules, click the new template. 
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6 Under Conditions, click . Then click the Field box three 

times and click a field whose value you want to test. Repeat for 
each additional field you want to test. 

Conditions determine when a rule is applied. If all the field tests evaluate 
to True, the rule is applied.  

Note that the Field list contains single-choice fields only.  

7 If you created a dependent-values template, click  under 

Dependent Values, then click the Field box three times and 
click the field whose value you want to set. Repeat for each field 
whose value you want to set. 

If you created a possible-values template, click  under Possible 
Values, then click the Field box three times and click the field whose 
possible values you want to specify. Repeat for each field whose possible 
values you want to specify.  

Note that the Field list contains single-choice fields only.  

Defining Rules  

Defining a rule involves filling in the template with specific values.  

Note that while you edit rules, you can edit the values, but you cannot add or 

remove fields. To add or remove fields you must edit the rule template.  

To define a rule:  

1 Select a rule template in the Workflow Editor. 

2 Click Rule and then click Add. 

3 Under Conditions, specify the values to test. For each field, 
click the Value box three times and then click the field value 
you want to test for. 

4 If you are defining a dependent values rule, then under 

Dependent Values, for each field, click the value you want to 
set. To use the value of another field, double-click the <Value 
of Field???> macro. 

If you are defining a possible values rule, then under Possible Values, 
for each field, select the check boxes for each possible value.  

5 Click Apply to apply the rule to the Web views of the project. 

 

Note: You can also copy a rule and edit it. To copy a rule, click the rule, then 

click Rule, click Copy, and type a name for the new rule. 
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Exercise:  Create a Country / State Workflow 

6 Create the fields, workflow template and rules required to create 
the workflow shown in the following diagram. 

 

 

User selects a value 
from the Country field 

United States Canada 

California 

Florida 

Nevada 

Minnesota 

New York 

Quebec 

Ontario 

Alberta 

Manitoba 

User selects a value 
from the State field 
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Managing Inventory Integration 

During the installation procedure for Vector Issue Tracker, the connection to a 

Vector Inventory database was configured. There may be a time when you 

want to change the name of your Enterprise Site or the location of your 

database. These changes must be applied to Vector Issue Tracker to ensure 

the latest data can be displayed. 

Exercise: Getting the Site Database Information 

To integrate Vector Inventory with Vector Issue Tracker, you need to know the 
type (Access or SQL), name, and location of the Site database, and whether 
you need a user account and password to log on to the Site database. 

To get the type, name, and location of the Site database: 

1 In the Console tree, expand the Site, and then click Site 

Management. 

2 In the Details pane, click Database and Licensing. 

The Database Location box specifies the type, name, and location of 
the database. For example: 

ACCESS MySiteDB \\server\share\MySiteDB.mdb  

-or- 

SQL SERVER MySite MySQLServer MySiteDB 

To get the logon information for the Site database: 

1 In the console tree, click Enterprise Management. 

2 In the Details pane, click Logon Information. 

Exercise: Changing your Site Database 

You can connect different Projects to different Site databases, but each Project 
can be connected to only one database. 

Pop-ups must be enabled on your browser for this exercise. 

1 Log on to Issue Tracker Web Admin as admin. 

2 Click the Inventory tab. 

3 In the Project list, select the HelpDesk Project. 

4 Remove the current database link by clicking the Remove 

button. 

5 Click the Link button. A new explorer window opens. 
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6 The Link Site Wizard guides you through the process of adding 

a Site to the HelpDesk Project. Click Next. 

The Link Site Wizard lists any Sites it finds on the Issue Tracker 
machine. 

7 If your Site is listed in the Detected Sites list, select the radio 

button and click Next. 

If your Site is not listed:  

a Select Other Sites and click Next. 

b Specify the Site Name by typing it in the box. 

c Enter a description of your Site. 

d Select the type of database used by your Enterprise Site. 

e Enter the location of your Site database. The location must be 
entered as UNC path. 

f Enter a username and password that has access to the database. 

g Click Next. 

8 Check the details on the Confirm Site page. Click Finish to 
complete the change. 

Adding the Inventory Tab to a View 

It may be necessary to add the Inventory tab to a new view. The following 

exercise demonstrates how to add the Inventory tab to a view using the Issue 

Tracker Web View Editor. 

Exercise: Adding the Inventory Tab to a View 

1 Log on to the Web View Editor. 

2 In the Project / View list, select HelpDesk / HelpDesk.  

3 In the shortcut bar, click  Fields. 

4 In the Tab list, select Inventory. Add all the Inventory fields to 

the Export To View list. 

You have to export at least the Client Name field. Export all the 
Inventory fields to ensure the Inventory reports work. 

If you don't export all the fields, the System Summary report will be 
incomplete or display the error message "The field name is not known". 

5 Click  to generate the view. 

6 When the view is generated, click Test  to log on to the view. 
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7 Create a new issue and type the name of a computer in the 

Computer Name field, then click the Inventory tab to display 
the inventory information for the specified computer. 

 

Adding the Inventory tab also adds Software and Hardware buttons 
to the view. These buttons allow users to generate Inventory reports for 
the entire Site.  

 

You can hide these buttons by disabling the corresponding features (in 
Issue Tracker Admin, click Tools > Security, click the Group tab, select 

a group, and disable the Report Viewer – Hardware Inventory and 
Report Viewer – Software Inventory features). 
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Service Level Agreements 

Service Level Agreements (SLAs) are contracts between a service provider 

and the customers that document agreed service levels for a service. In Issue 

Tracker, they enable support staff to optimize their workloads by identifying 

when each issue should be fixed and by providing automatic warnings and 

escalations when a target deadline is reached. In addition, SLAs also allow 

organizations to track and manage quality targets by providing information on 

the overall performance of the help desk and how well service targets are 

being met. 

 

Working with SLAs 

When you add an issue to Issue Tracker, it automatically checks the details 

against the service agreements that have been specified for the project. If the 

Contact and Service Type values of the Overview tab match those of a 

current agreement, Issue Tracker displays a flag in the Summary list, 

indicating that the issue is subject to an agreement. Issue Tracker also 

calculates target response and completion times for the issue from the terms 

of the agreement and displays them in the SLA tab of the Console’s Issue 

section. In addition, the color of the flag changes to indicate how close the 
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issue is to the specified completion targets.  The target completion times and 

the escalation state depend on the terms of the governing agreement.  

Exercise: Working with SLAs 

This exercise demonstrates SLAs using a service agreement from the default 
HelpDesk project. It contains the following targets for dealing with issues: 

 

1 In Issue Tracker, log on to HelpDesk / HelpDesk as admin 

(password = admin) and make sure that Summary Layout is 
selected for All Issues. 

2 Enter a new issue with the following information: 

Contact: Employee 

Owner: <None> 

Progress: New 

Priority: High 

Service Type: Network 

Problem Area: System – Network 

Summary: The network is running really slowly. 

Description: It is taking a long time to copy files to the server. 

Click Save. 

After a few minutes, Issue Tracker evaluates the information and 
identifies the issue is subject to a service agreement.  

3 Select the SLA tab. It lists the response and resolution targets 

for this issue and the name of the service agreement from which 
the target values are derived. 

If the Service Type and Target Initial Response Time are not 
displayed, click the Update SLA button to display the SLA information. 

4 Click the Refresh Query  button in the Summary list. A 

green flag is displayed to the right of the issue to indicate it is 
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covered by a service agreement and it is currently at escalation 
level 1 (New Issue). 

You can display the service agreement details of issues in the Summary 
list by selecting SLA in the Layout field. 

5 Enter the current date and time in the Actual Initial Response 

Date and Actual Initial Response Time fields to record you 
are about to request more information on the problem and click 
Save.  

If the person is unavailable, or you are waiting for input from an outside 
source, you can select Paused in the Escalation State field to suspend 
the timer until you are able to continue. 

If you resolve the issue within the Target Closure Time displayed, the 

Escalation Level will remain at 1 to indicate that the issue is being 
handled within the specified targets.  

If you do not enter an initial response time within the specified target 
and the Escalation State is not Paused or Off, the following events will 
occur: 

 10 minutes before the initial response is due, Issue Tracker sends 
an e-mail warning to the person specified as the current owner of 
the issue.  

 5 minutes after the initial response is due, Issue Tracker sends an 
e-mail warning to the issue owner and increases the Escalation 
Level to 2. The flag color changes to blue. 

 30 minutes after the initial response is due, Issue Tracker sends 
an e-mail warning to the issue owner and increases the 
Escalation Level to 3. The flag color changes to yellow. 

If you do not resolve the issue within the specified target time and the 
Escalation State is not Paused or Off, the following events occur: 

 10 minutes before the resolution is due, Issue Tracker sends an e-

mail warning to the issue owner.  

 5 minutes after the resolution is due, Issue Tracker sends an e-
mail warning to the issue owner and increases the Escalation 
Level to 4. The flag color changes to orange. 

 60 minutes after the resolution is due, Issue Tracker sends an e-
mail warning to the issue owner and increases the Escalation 
Level to 5. The flag color changes to red. 

6 Complete the issue following the normal workflow. 
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Configuring SLAs 

Before you can use Service Level Agreements to manage escalations and 

monitor performance, you must specify:  

 The number and type of escalation warnings you want to use 

 Which elements of your IT infrastructure you want to manage 

 The levels of service available to customers 

 The services that have been agreed between your help desk and its 

customers 

The following sections describe these processes in detail. 

Defining SLA Variables 

In essence, Service Level Agreements provide a method for ensuring that 

issues raised with a help desk are resolved in a timely and efficient manner. 

In Issue Tracker, this is managed by defining a set of targets for the time 

taken to respond to customers that have raised issues, and by providing a 

system of automatic warnings and escalations of issues when the targets are 

not met.  

Before you can create SLAs in a project, you must define the values for two 

fields that are used to control the progress of escalations through the system:  

Escalation Levels provide a signal to support staff on where an issue is in 

relation to its assigned targets. Normally, when an issue is first entered into 

the system, it has an escalation level of 1. By default, this is indicated by a 

green flag in the Web view Summary list. Then, as the issue reaches trigger 

points defined in user-specified rules, its escalation level is automatically 

updated by the system and the flag changes color.  

You can define as many escalation states as you want to use in your system. 

However, you must take care when deciding on how many you create, as 

these must be used by all SLAs in a project. For demonstration purposes, the 

HelpDesk project uses five.  

Escalation States give support staff the ability to control the progress of 

escalation levels. For example, if a customer is unavailable when a help desk 

analyst calls to collect more information about an issue, the Paused 

escalation state in the HelpDesk project gives the analyst the ability to 

suspend escalation until the customer returns. Again, the Escalation States 

you define are used throughout a project, so you must give some thought to 

the requirements of all the Service Level Agreements you are likely to 

implement. 
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Exercise: Editing Escalation Levels 

1 In Issue Tracker Web Admin, click the Choices tab. 

2 In the Project list, select HelpDesk. 

3 In the Choice List, select Escalation Level. The Escalation 

Levels for SLAs in this project are displayed in the Choices list.  

 

4 Click the Add Choice  button.  

5 In the Add Choice dialog, enter Level 6 in the Choice field, 
enter Black in the Color field and click OK.  

Exercise: Creating Escalation State 

1 In Issue Tracker Web Admin, click the Choices tab. 

2 In the Project list, select HelpDesk. 

3 In the Choice List, select Escalation State. The Escalation 

States for SLAs are displayed in the Choices list.  

4 Click the Add Choice  button.  

5 In the Add Choice dialog, enter See Parent in the Choice field, 

and click OK. 
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Service Types  

Service Types identify the different elements in your organization that you 

want to manage. For example, you can create service types based on your IT 

infrastructure, or you can create service types that cater for the particular 

needs of the different business units or functions within your organization.  

When you have created the Service Types for your organization, you can 

then specify the level of service you want your support staff to provide and the 

target response and resolution times for each service type. This enables you 

to differentiate the priorities you apply to each type of issue and to specify the 

targets for the various levels of support your help desk provides.  

Exercise: Creating Service Types 

This exercise demonstrates how to create a service type in the default 
infrastructure-oriented project supplied with Issue Tracker. 

1 In Issue Tracker Web Admin, click the SLA tab. 

2 In the Project list, select HelpDesk. 

3 Select Service Types . The Choices list displays the 

Service Types available to users of the HelpDesk project. 

 

4 Click the Add Choice  button.  

5 In the Add Choice dialog, enter Peripherals in the Choice field, 
and click OK. The new Service Type is displayed in the Choices 

list. 
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Service Levels  

One of the aims of a Service Level Agreement is to regularize the way in 

which each type of issue is handled. Issue Tracker does this using Service 

Levels. Each SLA must have a Service Level that defines a set of target times 

for responding to and resolving issues of different priorities. This not only 

provides users with a set of deadlines they can expect for the resolution of 

issues they raise, but also enables managers to check that their support 

targets are being met. In addition, Service Levels also give administrators the 

ability to automate the actions to be taken when a target is breached. These 

levels can range from sending warnings of imminent target failures, through 

increasing the priority or severity of an issue, to diverting issues to other 

support staff.  

 

Exercise: Editing Service Levels 

This exercise demonstrates how to use the default Service Levels provided as 
part of the HelpDesk project.  

1 In the SLA tab of Web Admin, make sure HelpDesk is the 
selected Project. 

2 Select Service Levels . 

3 In the Service Level list, select Gold. The Target Times tab 

lists the priorities that can be assigned to issues in the HelpDesk 
project and the target response and closure times for each 
priority in the service level. 
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By default, the HelpDesk project contains three service levels: Gold, 
Silver and Bronze. You can add your own service levels to the project, or 
edit the existing levels by clicking the buttons to the right of the Service 
Level list.  

4 Double-click the Highest entry in the Priority list.  

5 In the Edit Target Times window:  

a Enter an Initial Response Time of 15 minutes. This will 
enable you to see a Service Level in action soon after an 
issue is raised.   

b Leave the Closure Time unchanged and click OK to save 
your changes.  

6 Select the Escalation Rules tab to list the automatic actions 

associated with this Service Level. Double-click the New Issue 
Submitted entry to view the details of the rule. The Update 
Escalation Rule window is displayed. The window is divided into 
two sections: 

 Conditions specifies the circumstances that trigger the rule. 

 Actions specifies the actions that Issue Tracker performs when 

the rule is triggered. 

 

In this example, the escalation rule specifies that when an issue is 

created (identified by a Progress value of New), a value of Level 1 is 
assigned to the Escalation Level field (shown in the issue’s SLA tab) 
and an e-mail is sent to the person listed as the Owner of the issue. 
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7 Close the Update Escalation Rule window. Open some of the 

other rules and try to find out how they work. For example, 
notice how the Escalation Level is changed by each of the CT 
Reminder rules. These changes determine the color of the 
warning flag shown against the issue in the Console’s Summary 
list.  

8 Create a rule that automatically assigns an issue to a second-

level support team when it is 90 minutes overdue. To do this: 

a Click Add to create a new escalation rule.  

b In the Escalation Rule Name field, enter Transfer to 
Software Support. 

c Enter a condition of 90 minutes after the issue’s 

Target Closure Time and make sure it is enabled. 

d Select Severity and change the Value to Highest. 

e Select Update Assigned Work Team and change the 
Value to Software Support. 

f Select Update Escalation Level and change the Value 
to Level 6. 

g Select the first Send an e-mail to entry in the Actions 
list. In the E-mail Content Editor, enter your e-mail 
address in the To field, enter a warning message in the 
Body field, and click OK.  

h Click OK to create the new rule. 

9 Select the Operational Hours tab. This lists the periods during 

which the SLA timings apply. If an issue is raised outside the 
specified times, the escalation timings of the service agreement 
do not begin until the Start Time of the next working day 
specified in the Operational Hours list. Leave this page 
unchanged. 
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Service Agreements 

Service agreements record the details of the support that your help desk is 

contracted to supply to its customers. They specify what is to be supported 

(the Service Type), and the support targets (the Service Level) for each set of 

customers the help desk serves. In addition, they specify the duration of each 

contract, and, optionally, the customer and support staff responsible for 

contract management. 

Service agreements also enable systematic quality management of your help 

desk services by automatically storing information on issues that have failed 

to meet the support targets, and compiling and supplying regular reports that 

can help you decide whether your help desk services satisfy the requirements 

of your organization and are performed cost-effectively and as planned. 

Exercise: Creating Service Agreements 

1 In the SLA tab of Web Admin, make sure HelpDesk is the 
selected Project. 

2 Select Service Agreements . The Service Agreement list 

displays the service agreements that are defined for the 
HelpDesk project. 

3 Click the Add button to create a new service agreement. The 

Add Service Agreement window is displayed.  

4 In the Agreement Name field, type Agreement with 

Marketing Department.  

5 In the Agreement is with a list, select Department.  

Service agreements can be with individual users, with a department or 

business unit, or with companies. The selection you make controls the 
contents of the Agreement Customer list.  

6 In the Agreement Customer list, select Marketing. 

7 In the Service Type list, select Software.  

If you created the Peripherals service type in the earlier exercise, it 
should be displayed in this list. 

8 In the Service Level list, select Gold to specify the target times 

for responding to issues raised by users in Marketing. 

9 Enter today’s date in the Agreement Start Date field and enter 

the anniversary of today’s date in the Agreement End Date 
field to create an agreement that lasts for one year. You can 
type the date in the format specified by your system locale, or 

click the appropriate Calendar  button to select the date. 
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10 To configure Issue Tracker to send an automatic reminder that 

an agreement is due to expire: 

a In the Point of Contact (Provider) list, select Jean 
Manager. 

b Enter a Review Date that is one week before the 
Agreement End Date you specified. 

c Select the Send the Point of Contact (Provider) a 

reminder check box, and enter 28 in the days before 
Review Date field. 

11 Issue Tracker automatically stores information on all issues 
covered by a service agreement and the number of missed 

targets. Select an entry in the Reporting Period list to specify 
the frequency with which you want Issue Tracker to compile 
reports for this agreement.  

You can view the reports for a service agreement by clicking the Reports 
button in Web Admin’s SLA tab. 

12 Select the Service Agreement is enabled check box to enable 

the Service Agreement.  

You can suspend a service agreement at any time by selecting the 
agreement in the SLA tab, clicking Edit, then deselecting this option. 

13 Click OK to save your changes. The agreement is displayed in 

the Service Agreement list, and is automatically applied to all 
new Software issues raised by the Marketing department. To 
retrospectively apply the new service agreement to existing 
Marketing Software issues:  

a Select the new agreement in the Service Agreement list, 
and click Apply.  

 

b In the Apply all Agreements to Issues window, select All 
Open Issues and click OK.  

14 When you have finished, close Web Admin.  
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Service Level Reporting  

Vector Issue Tracker includes a set of service level reports to help you 

monitor and measure help desk performance against service level objectives,  

Exercise: To view a service level report:  

1 In Web Admin, click the SLA tab. 

2 In the project list, click a project. 

3 In the Service Agreements section, click Reports. (If 

the Reports button is disabled, click a service 

agreement.) 

4 In the Service Agreement Reports dialog, click the 

report you want to view, and then click OK, or double-

click the report.  

5 In the toolbar of the Crystal Reports viewer, click  to 

print the issue. Click  to save the report as PDF, 

Word, or Excel. 
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Setting Up E-mail Integration 

In addition to enabling users to submit issues through Web views, you can 

configure Issue Tracker to directly accept issues submitted by e-mail, as well 

as keep track of all e-mail conversations associated to the issue. This 

provides an easy-to-use interface with which most users are already familiar, 

and enables support staff to manage e-mail exchanges with users without 

having to spend time entering the details of conversations. 

To configure your system to accept e-mail issues: 

1 Open Web Admin 

2 Log on as a user that belongs to the Administrators group. 

3 In Web Admin, click the E-mail tab and click Incoming Mail. 

4 Select the Project for which you want to enable e-mail 

integration. 

The E-mail Integration Process 

Configuring Issue Tracker to accept issues submitted by e-mail is a multi-

stage process: 

Click Add a new Integration to enter the details of an e-mail address you 

want to use to submit issues to the project and keep the e-mail exchanges. 

The Add E-mail Integration Account window is displayed. 

For each e-mail address you want Issue Tracker to monitor, there are four 

main configuration steps that must be taken: 

1 Specify the E-mail Integration Account details.    

The information that will enable Issue Tracker to access the mailbox you 
wish to monitor for incoming mail. 

2 Configure Mail Handling Rules. 

These are the rules that govern how incoming e-mails are handled.  

3 Map message fields to issue fields 

Allows you to select the information you want to copy from e-mails to the 
associated issue. 

4 Configure Default Values 

This step is needed to provide values for the fields that cannot be 
populated from e-mail fields. Default values can be set globally, but they 
can also be overriden in each individual e-mail rule.  

 We will now look at these four steps in further detail. 
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1. Specifying the E-mail Integration Account Details 

Before Issue Tracker can convert e-mails to issues, you must specify the 

addresses that you want to use for submitting issues. 

To specify the details of the e-mail account you want to integrate with Issue 

Tracker: 

1 In the Hostname field, enter the name or IP address of the POP 

e-mail server that handles incoming e-mail. 

2 In the Port field, enter the port through which the e-mail server 

communicates. By default, POP uses port 110. 

3 Enter a Logon and a Password for the account that Issue 

Tracker will use to access the e-mail server. 
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2. Configure Mail Handling Rules 

Mail handling rules determine how e-mails sent to the address specified in the 

Incoming E-mail Server section are processed.  

When an e-mail is received, Issue Tracker compares the e-mail fields with the 

conditions specified in the first entry of the rules list. If the e-mail matches all 

conditions specified in the rule, Issue Tracker executes the specified actions, 

and then processes the next e-mail. If any of the conditions in the rule are not 

met, Issue Tracker tests the e-mail against the conditions specified in the next 

rule, until it reaches the end of the rule list. 

There are three main types of Rule actions: 

Create New Issue 

When executed, this action will create a new issue in the Issue 

Tracker system. You have the opportunity to specify some rule-

specific default values, which will allow you to override any global 

default values that have been specified. Default values will be 

covered in Step 4, “Configure Default Values”. 

Send to Queue 

The Send to Queue action will simply send the e-mail that triggered it 

to the E-mail Queue.  

It is recommended to place a rule that has an Action Type of Queue 

as the last rule in the list to cover the possibility that the e-mail does 

not meet the conditions of any rule in the list, in which case, the e-

mail will be automatically added to the E-mail Queue for manual 

processing.  

Link to Issue 

Link to issue rules are used to link an e-mail to the E-mail 

Conversation of a particular issue.  

When this action type is selected, it must be accompanied by the E-

mail contains number identifier of existing issue in field 

condition. 

 

Only one of the main actions can be chosen per rule. There are, however, a 

couple additional actions that can be executed in addition to the main actions: 
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Additional Actions 

 Send an e-mail 

Allows you to pre-define an e-mail that should be sent when the rule 

is executed. 

To send an automatic e-mail as an E-mail Integration Rule Action: 

1 Log on to Web Admin. 

2 Click the E-mail tab and the Incoming Mail section. Select a 

Project, and then load an E-mail Integration. Once in the Edit E-
mail Integration screen, load a Mail Handling Rule, and select 
Send an e-mail as an Action. 

3 Enter the e-mail information and click OK. This e-mail will be 
sent when the conditions of the Mail Handling Rule are met. 

Tip: Automatic E-mail Integration Rule E-mail Actions are useful for 

providing information to the person who sent the e-mail. For example, 

e-mail actions can be configured to reply to the e-mail sender, 

potentially telling them the number of the issue their e-mail created. 

With that information, the sender can then follow up on the issue at a 

later time. 

 

 Run program 

This action can be used to run a program when the rule is executed. 

You cannot run a program that requires user input.  
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Exercise: Create an e-mail rule 

1 In the Mail Handling section, click the Add button. The Add 

Rule window is displayed. 

2 Enter a Rule Name. 

Enter the conditions you want the rule to test for.  

For example, to test the Body of the e-mail for the word 
problem:  

3 Enable the first empty condition by selecting its check box. 

4 Click <Field> and select Body. 

5 Click Is Equal to and select Contains. 

6 Type problem in the entry field. 

7 Next, enter the actions you want the system to perform when all 
the conditions are met.  
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For example, to configure the system to create an issue and 
send a reply to the person who sent the e-mail: 

A.   Select the Integrate e-mail with Issue Tracker check 
box. 

B.   Select the Create New Issue using these values radio 
button. 

By default, Issue Tracker completes the issue using the field 
mappings defined in the Issue Completion section of the Edit 
E-mail Integration Account window. To override these 
mappings for this rule only, click these values. For more 
information, see the next E-mail Integration configuration steps, 

“Map Message Fields to Issue Fields”, and “Configure Default 
Values”. 

C. Select the first Send an e-mail to checkbox. 

D. Click on the Send an e-mail link. 

E. When the e-mail editor appears, confirm that the fields are 
set as follows: 

To:  <Reply to Sender> 

Cc: <Reply to CC> 

From: <Integration E-mail> 

F. Enter the following message in the body: 

Thanks for contacting support. 

Your e-mail has been assigned to issue <Issue 
Number>. 

G. Click OK in the e-mail editor to save the Send E-mail 
action. 

8 Click OK to save the rule. The rule is added to the bottom of the 
mail-handling list. Ensure the rule type is “Create”. 

9 Select the rule and click the Up and Down arrows to specify the 

processing order for the rule. 

In most systems, the first rule checks whether an e-mail refers to an existing 
issue to avoid the possibility of creating duplicate issues. The easiest way to 
create this rule is to specify a condition that checks whether the e-mail contains 
a reference to an existing issue. If there is no match, only then should the 
system go on to check whether the e-mail contains details of a new issue. 
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3. Map Message Fields to Issue Fields  

When an e-mail is sent to a monitored address, Issue Tracker generates an 

issue and copies information from the e-mail to specified issue fields. Issue 

Tracker automatically creates a default mapping between the e-mail fields 

and specified issue fields when you integrate an account. For example, the 

body of the e-mail is copied to the issue’s Description field. However, you can 

change the fields that the e-mail information is copied to using the Edit 

Mapping button.  

To view the field mappings for the specified account: 

 Click the Edit Mapping button. The Edit Mapping window lists the fields 

in your selected project, with mandatory fields shown in red. 

 

To map an e-mail field to a project field: 

 Double-click the row of the project field you wish to map. The Edit 

Mapping Field window is displayed. 

 In the Edit Mapping Field window, select the E-mail Field you want to 

map to the selected project field, and click the OK button.  
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To undo a field mapping: 

 In the Edit Mapping window, double-click the mapping you want to 

cancel. 

 In the Edit Mapping Field window, deselect the Assign value to this 

field check box and click the OK button.  

 

Click the OK button to save your changes, and close the Edit Mapping 

window. 

In addition to the usual E-mail Fields, a special field called Lookup user from 

e-mail’s sender is included. If a project field is mapped to this field, the 

system will use the incoming e-mail’s From address in an attempt to find an 

existing Issue Tracker user or contact who matches the credentials. If a user 

is found, that user will be associated with the e-mail. Otherwise, a contact 

may be created automatically if the option Create a contact based on the 

“from” address in the Default Values is set. 

For example, a typical mapping could be like this:  

E-mail Field Vector Issue Tracker Field 

Subject Summary 

Body Description Log 

From Instead of mapping From to a Vector Issue Tracker field, you 

can use the <Look up User from sender’s e-mail> macro to fill 
in the field with Vector user ID. 

To Contact (this would allow you to search for issues submitted 
by e-mail)  
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4. Configure Default Values 

While the Edit Mapping window will allow associating e-mail fields to Issue 

Tracker project fields, it is possible to define a separate set of values that will 

be applied along with the imported e-mail fields. When Issue Tracker fields 

are not mapped to e-mail fields, or when those mapped values are empty, the 

default values are considered. There are two different types of Default 

Values: 

 Global Default Values are set in the Issue Completion section of 

the E-mail Integration Account window.  

 Rule Default Values can be set within any specific Rule that has 

Create as an Action Type, and if specified, they can override the 

Global Default Values. 

For example, you could have a Global Default Value that sets the Issue 

Tracker field Priority to Medium. This may be acceptable in the majority of 

cases, but for the sake of this example, let’s say a Rule is created to treat e-

mails sent from the CEO to the Issue Tracker system. In this case, you may 

want the issue Priority to be set to High, instead of Medium, but still use all 

other existing Global Default Values. By using the Rule Default Values, 

special cases like the one just described are possible. 
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If you mapped Lookup user from e-mail’s sender to any Issue Tracker field 

in the Edit Mapping window, selecting the Create a contact based on the 

“from” address if one doesn't already exist checkbox will enable the auto-

creation of contacts when no match is found in the system. (See Step 3, “Map 

Message Fields to Issue Fields”.) 

Exercise: Editing the Global Default Values 

1 Click the Windows Start button, and select Programs, Vector, 

Issue Tracker, Issue Tracker Web Admin. 

2 Log on as admin (password = admin). 

3 Click the E-mail tab. 

4 In the Projects dropdown box, select HelpDesk. 

5 Click Add a new Integration. 

6 Fill in the required fields in the Account Information and 

Server Information sections. Afterwards, use the Test button 
to make sure everything works. 

7 In the Issue Completion section, click Edit Defaults. 

8 Locate the Summary field, and consult the following note: 

 Notice how the Mapped to column says Subject. What 
this means is that an e-mail field is mapped to this Issue 
Tracker field. In this case, the e-mail subject will be used 
to populate the Summary – should this e-mail be used to 
create an issue. In addition, when we look at the Default 

Value column, we see it is set to (no subject in e-mail). 
This value will be used to populate the Summary field, if 
the cases where the e-mail subject is blank. 

9 Locate the Severity field. 

10 Click the Not set link that accompanies the Severity field. You 

can also just double-click the row. 

11 Ensure the Assign a value to this field checkbox is selected. 

12 In the Default Value dropdown, select: Medium 

13 Click OK. 

14 Click OK to save the Global Default Values. 

15 Select the Enable this integration checkbox. 

16 Click OK to save the E-mail Integration Account. 

Now, to test what we’ve just changed, try sending an e-mail to the integration 

e-mail address. Leave the subject blank so we can test that default value 
mechanism while we’re at it. We want the e-mail to end up in the e-mail queue. 
Once it arrives in the E-mail Queue, select the e-mail, and click Create Issue. 
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The resulting issue should have a summary that says (no subject in e-mail), 
and the Severity field should say Medium. 

Exercise: Setting Rule-specific Default Values 

  The Global Default Values exercise must be completed prior to this one.  

1 Click the Windows Start button, and select Programs, Vector, 

Issue Tracker, Issue Tracker Web Admin. 

2 Log on as admin (password = admin). 

3 Click the E-mail tab. 

4 In the Projects dropdown box, select HelpDesk. 

5 Select the integration you created in the Editing the Global 

Default Values exercise. 

6 Click the Edit the selected Integration button. 

7 In the Mail Handling section, select the Create new Issue 

rule. 

8 Click the Edit… button to edit the rule. You can also double-click 

the rule to edit it. 

9 Notice how the rule is configured: 

 The When all these conditions are met section has one 
condition: 

 Subject contains New 

 The Perform the following actions section has two 
actions: 

 Integration e-mail with Issue Tracker – Create 
New Issue using these rules. 

 Send an e-mail to <Reply to Sender> 

To trigger this rule, the e-mail simply needs to have New in the 
subject. Once triggered, it will create an issue using the e-mail, 
and send a message to the sender. 

 

10 Click on the these values link, which is found listed with the 

Create new Issue using these values action. 

11 A window called Default Values for the E-mail Rule opens. At the 

top of this window is a note. Read it carefully: 

When an issue is created, the e-mail values will be used to 
determine some of the Issue Tracker field values. When Issue 
Tracker fields are not mapped to e-mail fields, or when those 
mapped values are empty, the default values are considered. If 
there are default values specified within this specific rule, they 
will override any global default values. The Global Default Values 
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are accessible from the Issue Completion section of the E-mail 
Integration Account window. 

This window goes one step further than the global defaults 
window. Not only does it show you the mapping (via the 
Mapped To column), but it shows you both global and rule-
specific defaults.  

 

12 Locate the Priority field in this window. 

You’ll notice that it has a default value in the Default Value 
column, and this value is High. You’ll also notice that the Using 

Global? field has a green checkmark  for this row. This 

means the value High is actually a global default value, not a 
rule-specific default value. 

13 Click the High link on the Priority row, or double-click the row. 

14 In the Default Value dropdown, select Medium. 

15 Click OK. 

16 Notice how the row no longer has a green checkmark in the 

Using Global? column. This is because we just set a default 
value that is going to be used only for this rule. 

To set it to use the global default value as before, simply repeat 
step 13, and uncheck the Assign a value to this field to 
override the global default value checkbox. 

17 Click OK in the Default values for the E-mail Rule dialog. 

18 Click OK in the Edit Rule dialog to save your changes. 

We’ve finished configuring the Create New Issue rule. Next, 
we’re going to create a new Create New Issue VIP rule, which 
will have an extra condition that checks for the presence of a 
VIP address in the e-mail From field. If the Create New Issue 
VIP rule is executed, we want to make sure the Priority is set to 
Highest, not Medium. 

19 Select the Create New Issue rule you just saved. 

20 Click Copy. 

21 In the Copy Rule dialog, enter: Create New Issue VIP 

22 Select the Create New Issue VIP rule. 

23 Click Edit. 

24 Click on the <Field> link right after the Subject link, and select 
From. In other words, use a condition row that is currently not 
being used. 

25 In the textbox, write a valid e-mail that you can send e-mails 
from. Click on the checkbox to the left of the row to activate the 
condition. 
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26 Click on the these values link, which is found listed with the 

Create new Issue using these values action. 

27 Click the Medium link on the Priority row, or double-click the 
row. 

28 In the Default Value dropdown, select Highest. 

29 Click OK. 

30 Click OK in the Default values for the E-mail Rule dialog. 

31 Click OK in the Edit Rule dialog to save your changes. 

We’ve finished configuring the Create New Issue VIP rule; 
however, we still need to place it properly in the Mail Handling 
sequence. 

32 In the Mail Handling rule list, use the arrow buttons  
to make sure the Create New Issue VIP rule is right above the 
Create New Issue rule. 

The Create New Issue VIP rule is placed above the Create New 
Issue rule because it has more conditions.  

If the Create New Issue rule were to be placed above the Create 
New Issue VIP rule, the Create New Issue VIP rule would never 
be executed. This is because the original Create New Issue rule 
will execute when it sees New in the subject, and once it 
executes, no other rules are considered. To get around this, we 
can place the rule with the most conditions first, in this case, 
Create New Issue VIP. 

33 Click OK to save the changes to the e-mail integration account. 

Now we test the changes. You’ll notice that if you send the e-mail from the VIP 

address, the resulting issue will be created with a Priority of Highest, rather 
than Medium. 
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Mail Settings 

In order for the E-mail Integration to process incoming and outgoing e-mails, 

several Mail Settings must be configured in Issue Tracker. 
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To configure the Mail Settings: 

1 Log on to Web Admin. Click the E-mail tab and the Mail 

Settings section. 

2 Fill in the Outgoing E-mail Settings. These settings are used 
when sending e-mails. 

3 Click Test to ensure Issue Tracker is able to connect to the 

SMTP server using the settings you provided. 

Option Description 

Hostname 
The hostname or IP address of the SMTP server. For 

example: smtp.mycompany.com 

Port 
The port through which the SMTP server communicates. 

The default SMTP server port is 25. 

Logon 

The logon account used to gain access to the SMTP 

server. Use this only if your SMTP server requires 

authentication. 

Password 
The password for logging into the SMTP server. Use this 

only if your SMTP server requires authentication. 

Request Read Receipt 

Read receipts will appear in the conversation, confirming 

that the recipient has read the message. Note, however, 

that some recipients may choose to never send read 

receipts. 

Send Automatic E-mail 

Notifications From 

Name of the sender for SMTP e-mail. Some SMTP mail 

servers require the sender to be a valid e-mail address. 

Supported Formats: "Notification Service" 

<notificationservice@yourcompany.com> , 

notificationservice@yourcompany.com 

Send Automatic E-mail 

Notifications Every 

Send e-mail notifications at the specified interval (in 

minutes). 

Maximum Retries 

The maximum number of retries for e-mail notifications. 

Once surpassed, the e-mail will be sent to the address 

specified in the Send Failed Outgoing E-mails To. 

Send Failed Outgoing E-mails 

To 

If the Maximum Retries is surpassed, the e-mail will be 

sent to this address. If there is no address specified, the 

e-mail service will continue trying to send to the original 

recipient. 

 

Fill in the Incoming E-mail Settings. These settings are used when receiving 

e-mails, together with the Account, Server and Logon Information specified 

in the defined Mail Integrations.  

Option Description 

Check Server For New Mail 

Every 

Check for new incoming e-mails at the specified interval 

(in minutes).  
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Working with E-mail Integration 

Using the E-mail Editor 

The E-mail Editor allows you and your users to create and send e-mail 

messages from the Web view. You can also configure e-mail to be sent 

automatically from SLA or E-mail Integration (for example, when Issue 

Tracker creates a new issue from an incoming e-mail, or when an SLA rule 

changes the Owner of an issue). 
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Sending E-mails  

Editing the To, CC, and From Fields 

You can specify users by either looking up users and contacts in Issue 

Tracker, using macros or typing in the e-mail address directly. 

To lookup users and contacts in Issue Tracker, beside the To, CC, or From 

box, click  

In the Select Users and Contacts dialog box, double-click the users and 

contacts you want to add. 

The list of selected users and contacts is displayed under Selected Users 

and Contacts. You can edit this string of text, for example, to remove a user, 

or to add the e-mail address of a person who is not a user or contact. 

Notes 

The text box beside the Find button allows you to display all users and 

contacts whose names start with the same letters. In the text box, type the 

first few letters of the name and then click Find. 

To display the complete list of users and contacts again, delete all text from 

the box and then click Find.  

Click Advanced to search for all users and contacts whose names contain the 

same string, or to search based on e-mail addresses. 

If you would like to send separate e-mails to several recipients, select the 

Send e-mail to each recipient individually checkbox. If you have recipients 

entered in the CC field, you will not be able to send individual e-mails. 

Editing E-mail Content 

You can type in any text you want, and you can use macros to insert the 

issue number, the name of the project, and the values of different fields (such 

as the Summary and Description Log). These macros are covered in the next 

section, “E-mail Macros”. 

If you prefer your e-mail body to be in HTML format, click the HTML in Body 

checkbox. 

Attaching Files 

Beside the Attachments box, click . 

In the E-mail Content Attachments dialog, click Browse and locate the file you 

want to attach. Click Upload or Link. 

This adds the file to the list of files attached to this e-mail message. Every 

time the e-mail message is sent, the files are attached to the message. 
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E-mail Macros 

Macros are available when you use the E-mail Editor in the Web views and 

Web Admin.  

Macros resolve values for information related to the issue so you don’t have 

to look it up manually. 

  

Macro 
Available In 
Fields 

Description 

<Contact> To, CC, From 
The person who is entered in the Contact 
field in the issue. This is usually the person 
who reported the issue. 

<Owner> To, CC, From 
The person who is entered in the Owner field 
in the issue. 

<Previous Owner> To, CC, From 
The person who was entered in the Owner 
field in the issue before it was reassigned to 
a new Issue Tracker user. 

<Submitter> To, CC, From 
The person who is entered in the Submitter 
field in the issue. This is the person who 
entered the issue in Issue Tracker. 

<Work Team Members> To, CC 
The people who belong to the work group 
that is entered in the Assigned Work Team 
field in the issue. 

<Reply To Sender> To 

The person who sent the e-mail. This only 
applies when replying to an e-mail through 
the Conversation or Queue or from the E-
mail Integration Actions.  

<Reply To CC> CC 

The people who were CCed on the e-mail 
that was sent. This only applies when 
replying to an e-mail through the 
Conversation or Queue or from the E-mail 
Integration Actions. 

<Integration E-mail> From 
The e-mail address specified for the E-mail 
Integration Account. 

<Server Mail Sender From 
Admin Options> 

From 

The e-mail address specified in the Mail 

Settings for who to Send Automatic E-mails 
Notifications From. 

Field Value Subject, Body The value of a field in the issue. 

Issue Number Subject, Body The number of the issue. 

Project Name Subject, Body The name of the project the issue is in. 
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Link To Issue Body 

Generates a URL that you can include in the 
e-mail to allow people who have access to 
the Web views to log in to a specific view and 
automatically load the issue you specified. 

  

To use a macro: 

Position your cursor in the e-mail where you would like the resolved macro to 

be inserted. 

Click on the Macros tab.  

Click on the macro you would like to insert. In the Web views, the macro will 

be resolved to the current value. In templates and in Web Admin, the macro 

will remain unresolved so that it can be resolved when the automatic e-mail is 

sent or when the template is applied to an e-mail. 

Exercise: Using the “Link to Issue” Macro. 

1 Click the Windows Start button, and select Programs, Vector, 

Issue Tracker, Issue Tracker Web. 

2 Log on as admin (password = admin). 

3 Load the HelpDesk view. 

4 Load any issue. 

5 Click the E-mail Conversation button. 

6 Click on the New Mail button. 

7 In the E-mail Editor, click the Macros tab on the right. 

8 Click in the Body field so that you see the mouse cursor. 

9 Click the Link to Issue macro from the Available Macros 
menu. 

10 In the Web View dropdown, select HelpDesk/HelpDesk. 

11 In the Query dropdown, select All Issues. 

12 Click OK to close the window. 

The “Link to Issue” link appears in the e-mail body. You can now send the e-

mail, and when the recipient gets that link, they can use it to load the 

HelpDesk view, and it will automatically load the issue you selected in Step 4, 

with the query you specified. You can try it now by copying this link, and 

pasting it in a new browser window. 
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E-mail Templates 

Templates are available when you use the E-mail Editor in the Web views. 

Use templates to store reusable e-mail content so that your users can quickly 

create e-mails when standard responses are required. A template can contain 

Subject, Body and Attachment information. 

To create a template:  

All users who have access to the Web View – Manage E-mail Templates can 

create and edit templates. 

To create a template, open the E-mail Editor to create a new e-mail. Click the 

Templates tab and click Add a new template.  

By default, the new template is filled in with any subject, attachment and body 

text that was entered in the e-mail you added the template from. 

Enter a Name for the template, as well as any subject, attachment or body 

text that you want in the template. 

Click OK, and your new template will be available in the Templates list for all 

users who have the feature Web View – Manage E-mail Templates. 

To use a template: 

All users who have access to the Web View – Manage E-mail Templates can 

use templates. 

To use a template, open the E-mail Editor to create a new e-mail. Click the 

Templates tab and select the template you want to use. Click Apply the 

selected template.  

 

Exercise: Creating a Template 

1 Log into an e-mail integration enabled Web view:  

The user you are logging in with will need to have access to 
the “Manage E-mail Templates” feature. 

2 Open the E-mail Conversation of an issue of your choice. 

3 Click New e-mail. 

4 In the Templates tab on the right, click Add a new template. 

5 Enter the following values: 

Template Name:  Issue Info 
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Subject:  Your Issue Information 

6 Select the HTML in Body checkbox. 

7 Using the macros tab on the right, author the e-mail template 
body so that it will produce output similar to this example: 

Your issue, with the number is 32, has the priority Medium, and 
it is entered in the project HelpDesk.  

8 Click OK to save the template. 

9 Back in the E-mail Editor, double-click template you just 

created. 

The template should be automatically applied to the body, with 
all macros correctly resolved to the current issue’s values.  

Tip: If the e-mail body is plain text, the template will be 
inserted as plain text, even though it was authored in HTML 
mode. The opposite also works.  
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E-mail Conversation and Queue 

E-mail integration brings the ability to view support-related and other e-mails 

directly from the Web views. The E-mail Conversation and Queue are where 

you can view and manipulate these integrated e-mails. 

The E-mail Conversation 

The E-mail Conversation is where you can access all the e-mails related to a 

specific issue. 

To access an issue’s E-mail Conversation: 

1 Log on to the Web view where the issue can be found. 

2 Find the issue using the search feature. 

3 Select the issue from the summary list. 

4 Click  in the toolbar. 

The E-mail Queue 

The E-mail Queue is where you can access and process all the e-mails 

pending assessment from a help desk analyst. These e-mails have not been 

associated to any existing issue. 

To access the E-mail Queue: 

1 Log on to a Web view of the desired Project. (Each Project has 

its own E-mail Queue.) 

2 Click  in the toolbar. 

Processing E-mails in the Web View 

The E-mail Conversation and Queue are where integrated e-mails can be 

processed, in the Web view. There, you can: 

 Send a new e-mail. 

 Reply to an e-mail. 

 Forward an e-mail. 

 Link an e-mail to an existing issue. 

 Create a new issue from an e-mail. 
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Sending New E-mails 

E-mails are created and sent using the e-mail editor. 

You might be interested, for example, in sending an e-mail and keep a copy 

in an issue’s E-mail Conversation and Activity Log. 

New e-mails' fields will be completely blank with the exception of the From 

address which is determined by your E-mail Options, and the Subject which, 

for the Conversation only, is pre-filled with the respective issue number. 

To send a new e-mail from an E-mail Conversation or the E-mail Queue, click 

. 

Exercise: Send an e-mail containing information about the current issue 

3 Log on to a Web view. 

4 Load an issue and click on the  button. 

The E-mail Editor will open, with the default “Current Issue” 
Template applied. You can add the value of additional fields 
using the Field Value Macro. 

 

5 Click the Send button. 

This e-mail will be added to the issue’s Conversation if the Save 
to Conversation checkbox is selected. 

Replying to E-mails 

E-mail replies are created and sent using the e-mail editor. 

You might be interested, for example, in requesting more information from a 

customer after receiving a support e-mail. 

E-mail replies are pre-filled with the original e-mail’s content, and the From 

address is determined either by the original e-mail’s Integration Account’s 

(see Setting up E-mail Integration) e-mail address, or by your E-mail Options 

if the original e-mail didn’t come from E-mail Integration. 

To reply to an e-mail from an E-mail Conversation or the E-mail Queue, click 

 or , depending whether you want to reply only to the 

sender or to all the original recipients as well. 

Note: see Sending E-mails From Web views to see how an E-mail 

Conversation reply can automatically update the respective issue’s Actual 

Initial Response Date and Time. 
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Forwarding E-mails 

Forwarded e-mails are created and sent using the e-mail editor. 

You might be interested, for example, in sending a copy of a customer e-mail 

to a colleague for second-line support. 

Forwarded e-mails are pre-filled with the original e-mail’s content with the 

exception of the To recipient which is left blank. The From address is 

determined by your E-mail Options. 

To forward an e-mail from an E-mail Conversation or the E-mail Queue, click 

. 

Service Level Agreements (SLA) and E-mails: 

If the issue has an SLA agreement associated with it, the first time you send 

an e-mail from Issue Tracker to the Contact of the issue, the Actual Initial 

Response Date and Actual Initial Response Time fields in the issue will 

automatically be set to the date and time when the e-mail is sent (if they 

aren’t set already). 

Linking an E-mail to an Existing Issue 

Whether an e-mail is already in an issue’s E-mail Conversation or still in the 

E-mail Queue, you might find out it is related to some (other) existing issue. 

To link an e-mail to an issue, from an E-mail Conversation or the E-mail 

Queue, click . 

After the e-mail is linked to this new issue, it can be found in the issue’s E-

mail Conversation. The e-mail itself is actually moved to the new issue’s 

Conversation, not copied. The old issue will still have an Activity Log entry for 

the e-mail, even though it is no longer associated.  

Creating a New Issue From an E-mail 

Whether an e-mail is already in an issue’s E-mail Conversation or still in the 

E-mail Queue, you might decide a new issue needs to be created with 

regards to the information found in it. 

To create a new issue from an e-mail in an E-mail Conversation or the E-mail 

Queue, click . 

After the issue is created, you will receive a message stating the new issue’s 

number, and the e-mail will now be in this issue’s E-mail Conversation. The e-

mail used to create the issue is actually moved to the new issue’s 

Conversation, not copied. The Activity Log will also have an entry for this e-

mail. 
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Web View E-mail Options 

The Web view E-mail Options affect all e-mails created from the Web views, 

be it from the E-mail toolbar button, an issue’s E-mail Conversation or the 

E-mail Queue. 

Two options are available to Web view users regarding e-mails: 

 The From address to be used when composing e-mails. 

 The requesting of read receipts. 

By default, every user’s E-mail Options are: 

 From Address: their own e-mail address. 

 Read Receipts: requested. 

To change your E-mail Options: 

1 Log on to a Web view. 

2 Click in the toolbar. 

3 Click the E-mail tab to open it. 

4 Perform the desired changes and click OK. 
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The “From Address” E-mail Option 

You have the option to use the e-mail address of your Issue Tracker user 

account or any other e-mail address, when sending e-mails from Web views. 

No matter what this option is set to, replies to e-mails coming from an E-mail 

Integration Account will always have the respective account’s e-mail 

address as their From address. 

The “Read Receipts” E-mail Option 

You have the option to request a read receipt for all the e-mails you send 

from any Web view. 

Depending on the From address of your e-mails and the E-mail Integration 

configuration, these read receipts can be processed automatically by the E-

mail Integration feature. 

Note that read receipts can be recognized by their subjects starting with 

“Read:”. 

The “E-mail Signature” E-mail Option 

Issue Tracker allows each user to define an e-mail signature which can be 

automatically applied whenever the e-mail editor is used. It is also possible to 

control when you want to have the signature automatically applied… 

specifically, you can enable or disable the signature when: 

 Composing a new –email 

 Replying to an e-mail 

 Forwarding an e-mail 

You can also decide whether you want an HTML signature, or a plain text 

signature. If you’re replying to a plain text e-mail, and your signature was 

created in HTML mode, Issue Tracker will automatically convert your 

signature to plain text before it adds it to the e-mail editor. The opposite is 

also true. 
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Exercise: Create an e-mail signature 

1 Select the E-mail Signature checkbox. 

2 Click the Edit button. 

3 In the Edit Signature dialog, enter the following: 

Jean Manager 

HelpDesk Analyst 

4 Press OK to save the signature. 

5 In the Apply to New E-mails field, select Yes. 

6 In the Apply to Replies field, select Yes. 

7 In the Apply to Forwards field, select No. 

8 Click OK to save the options. 

 

Finally, test the signature. Trying composing new e-mails, replying, and 

forwarding existing e-mails. The signature should be applied when you author 

new e-mails, or when you reply – not when you forward.  
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The CustomizedFiles Folder 

Customizing Web View Files  

To customize specific Web views without editing the generated files, you put 

your customized files in a special CustomizedFiles folder. Each time you 

generate the view, the Web View Editor copies your customized files from the 

CustomizedFiles folder into the view.  

 

The basic steps to customizing Web view files are: 

1. In the “<IssueTrackerServer>\CensusWeb” folder, create a 

CustomizedFiles folder. 

<IssueTrackerServer> represents the folder where your Issue Tracker 

Server is installed. Usually, this is C:\Program 

Files\Vector\IssueTrackerServer. 

2. In the CustomizedFiles folder, create a folder structure to hold the 

customized files. 

3. Copy the files you want to customize from the view into the 

CustomizedFiles folder, respecting the folder structure of the folders that 

are being customized. 

4. Customize the files and generate the view. 

To better understand these steps, we must first understand the architecture of 

the CustomizedFiles folder. 

 

Customized Files Folder Architecture 

Directly below the CustomizedFiles folder, folders can be created that: 

 represent a project, or all projects. 

 Example: “MyProject” 

 represent a virtual directory 

Example: http://server/vit (In this case, “vit” is the virtual directory) 

 



Vector Issue Tracker  Page 123 

 

Your notes: 

 

 

 

 

 

  Vector Issue Tracker 

Customizing Projects 

You have two options when adding folders to customize a project. You can 

either apply a customization to a specific project, or to all projects. 

Customizing All Projects 

To add customized files that will be used in all projects, create a folder called 

“#AllProjects#” in the CustomizedFiles folder. 

  

Anything you place in that folder will affect all projects, across all virtual 

directories. For example, you could place a customized “logon.asp” in that 

folder, and when the views are regenerated, it will overwrite the non-

customized version in “C:\Program 

Files\Vector\IssueTrackerServer\CensusWeb\Views\CensusWebVD”. 

Customizing a Specific Project 

To add customized files that will be used in a specific project only, create a 

folder using this format: #Project#<project>, where <project> is replaced by 

the name of the project you wish to customize: 

  

This, by itself, isn’t very useful – but it allows much flexibility when we start 

thinking about customizing the Web views within that project.  

 

Customizing Web Views 

Once we have a project folder in CustomizedFiles, we have the option of 

adding a Web view folder – this is where the true power lies. 

The folder naming is similar to the projects folders: #AllWebViews# targets all 

web views, and #WebView#<project>_<webview> targets a specific web 

view. 

Here are some examples that illustrate how to combine both the “Project” and 

“Web view” folders to customize Issue Tracker: 

 To customize files for all Web views of all projects, create this folder 

structure:  

 



Vector Issue Tracker  Page 124 

 

Your notes: 

 

 

 

 

 

  Vector Issue Tracker 

 

 To customize files for all Web views of a specific project, create a folder 

structure like this:  

 

 To customize files for a specific Web view of a specific project, create a 

folder structure like this: 

 

   

Structuring the Contents 

Once you have the folder structure set up, it is time to place the files that you 

wish to customize. The contents of the CustomizedFiles folders must respect 

the structure of the folders they are customizing. 

 

For example, if you want to customize all web views which belong to the 

project “MyProject”, you’d first have to determine which files you want to 

customize, and where they are placed. Here’s a typical Web view’s folder 

structure: 

 

Now, suppose we wanted to customize two files: 

TmplTopToolbar.html (from the HTML folder) 

Start.rec (from the MISC folder) 

Also, suppose we wanted to do this for all web views in the “MyProject” 

project.  

To achieve this, all we have to do is follow the same folder structure as the 

Web view folder, and reflect it in the CustomizedFiles folder: 
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We only need to create the folders that will contain customized files. Once the 

folders are there, the files must also be placed in their proper locations. From 

looking at the actual Web view folder earlier, we know that 

“TmplTopToolbar.htm” goes in the HTML folder, and “Start.rec” goes in the 

MISC folder.  

The same approach works with the Project and Virtual Directory folders – 

except in those cases, you must respect the folder structure of the 

CensusWebVD directory (By default: C:\Program Files\Vector\ 

IssueTrackerServer\CensusWeb\Views\CensusWebVD). 

 

Customizing Virtual Directories 

You can also customize the files that are shared by Web views accessed 

through the same URL. These are the files found in the “CensusWebVD” 

folder, such as “logon. asp”.  

 

 To customize the files in “CensusWebVD” for all Web views:  

Put the files in the folder  

CustomizedFiles\#AllProjects#  

-or- 

CustomizedFiles\<virtual directory>  

  …where <virtual directory> is the name of the virtual directory. 

 To customize files for all Web views accessed through a given URL: 

Create a folder structure like this:  

 

In this example, “Vit” is the last part of the URL used to connect to Issue 

Tracker. By default, this URL is in the form http://server/vit, where 

“server” is the name of the server where Issue Tracker is installed. The 

“vit” part of that URL is known as a Virtual Directory. 
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Use this approach if you generate Web views outside the 

IssueTrackerServer folder.  

NOTE: Customizations placed in the virtual directory folder will override any other 

project customizations that are within the same virtual directory. Even project-specific 

folders like #Project#HelpDesk are overriden when the virtual directory folder is used. 

 

Overriding Customizations 

It is also possible to apply customized files to all web views, and still override 

these files in specific web views. To do this, a folder must be created with a 

special format: 

#WebView#<project>_<view> 

Where <project> is the project name and <view> is the view name. 

Consider the following example: 

 

If any files found within “#WebView#MyProject_MyView” are also within the 

“#AllWebViews#” folder, the files within the “#WebView#MyProject_MyView” 

folder will be used. Essentially, the files within 

“#WebView#MyProject_MyView” will override all “#AllWebViews#” files; 

however, this is only true for the specified view – in this case, “MyView”. 

 

NOTE: You can use this #WebView#<project>_<view> format in any of the 

three top-level customization folders (#AllProjects#, #Project#<Project>, and 

Virtual Directory) 
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Custom Reporting – Crystal Reports with Issue Tracker 

Building Custom Reports  

Using Crystal Reports, you can add features such as charts, formulas, field 

highlighting, and running totals to a listing report. You can also import 

graphics (such as company logos) and completely reformat a listing report. To 

build custom reports, you need a version of Crystal Reports that is version 8.5 

or beyond. 

Customized listing reports appear on the Custom tab of the Issue Tracker 

Web Report Viewer. After you customize a listing report, you cannot edit it in 

the Report Editor. You must use Crystal Reports.  

While Issue Tracker comes with numerous custom reports out of the box, it 

may be desirable to create additional custom reports. The process of creating 

such a report is as follows: 

1 Open the Report Editor for the desired project. 

2 Select the Listing tab. 

3 Locate a report that has the Custom Report checkbox checked. 
If checked, this indicates that the report will appear in the 
Custom tab of Reports section of the Web views. 

4 Click the Copy Report button. Choose a name for the new 

report, type it in, and press OK. 

5 Press Apply to save your changes. 

 

Note: After doing this, Issue Tracker will have already saved two .rpt files in 

the CustomizedFiles folder allocated to this project. In order to view the 

reports in the Web views, they must be moved to the Web view folder. This 

can be achieved by regenerating the Web views that are related to the 

project. 

     Example: 

           CUSTOMIZEDFILES\#Project#HelpDesk\#AllWebViews#\ 

6 Regenerate the Web views that are related to the project.  

7 Navigate to the Web view's Reports folder, and locate the two 
.rpt files. From here you can use Crystal Reports to edit the .rpt 
files.      If you wish to add, change, or remove fields, create 
cross tabs, or add new charts, you will need advanced 

knowledge of Crystal Reports. Please contact support for more 
information. 
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If the report name is "Open Issues - Age by Priority" then the filenames will 

be: 

     rptListingGOpen$Issue$-$Age$by$Prioritylandscape.rpt 

     rptListingGOpen$Issue$-$Age$by$Priorityportrait.rpt 

Once the modifications have been made to both files, they must now be 

copied to the CustomizedFiles folder to ensure they will be included the next 

time the Web views are generated. 
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Adding Fields to Custom Reports 

1 In Issue Tracker Admin, select a project and open the Report 

Editor. On the Listing tab, add one or more fields to a custom 
report. You can insert the new fields anywhere (for example, in 
between two existing report fields). 

2 Log on to a Web view of the project and view the custom report. 

Issue Tracker dynamically adds the field when you view the 

report BUT Issue Tracker does not save the changed report. You 
have to do that yourself (see step 3). 

3 From the report viewer, save the report in the Reports folder. Do 
this for both the Portrait and Landscape versions of the custom 
report. 

The Reports folder is located in the IssueTrackerServer folder. 

For example: 

C:\Program Files\Vector 
 \IssueTrackerServer\CensusWeb\Views\CensusWebVD\Hel
pDesk_HelpDesk\Reports 

4 In Crystal Reports, open one of the .rpt file you just saved. The 

report includes the new field (to check: in the Field Explorer, 
expand Database Fields and then expand ado). 

Note that if you insert the new field into the report and then try 
to preview the report, Crystal Reports will display an OLE DB 
Provider dialog box and prompt you to select a data source. 

When this happens, just click Cancel. Issue Tracker sets the 
data source at runtime.  

If you want to be able to preview changes in Crystal Reports: 

 Save the report. If you get a "Unable to Save Data With 
Report" message box, click No. 

 In the Web view, view the report and save it again (this 
time the saved report will include the data required by 
Crystal Reports for previewing). 

 Open the report in Crystal Reports: now you can preview 

the report without being prompted for a data source. 

5 Copy the modified .rpt files to the CUSTOMIZEDFILES folder. If 
you don’t, your modified custom reports will be overwritten the 
next time you generate the Web view. 

 

Note: In general, any time Crystal Reports asks you to either used 

saved data or refresh data, use the saved data. Refreshing the data 

requires that you select a data source, and the data source should be 

set only by Issue Tracker at run time (when a user views the reports). 
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Removing Fields from Custom Reports 

1 In Issue Tracker Admin, select a project and open the Report 

Editor. On the Listing tab, remove a field from a custom report. 

2 Log on to a Web view of the project and view the custom report. 

When you view the report, Issue Tracker dynamically updates 
the list of fields included in the report BUT Issue Tracker does 
not save the changed report. You have to do that yourself (see 

step 3). 

If you get a “This field name is not known” message, then 
the field is used in a formula somewhere in the report. If this 
happens, you must open the .rpt file in Crystal Reports, find the 
formulas that use the field, and remove all references to the 
field.  

If the field was displayed in the report, or used to define a chart, 
you’ll see a blank space in the report where the field or chart 
were supposed to be. 

3 From the report viewer, save the report in the Reports folder. Do 

this for both the Portrait and Landscape versions of the custom 
report. 

The Reports folder is located in the IssueTrackerServer folder. 
For example: 

C:\Program Files\Vector 
 \IssueTrackerServer\CensusWeb\Views\CensusWebVD\Hel
pDesk_HelpDesk\Reports 

4 In Crystal Reports, open one of the .rpt file you just saved. The 

report no longer includes the field you removed (to check: in the 
Field Explorer, expand Database Fields and then expand ado). 

5 Update the custom report as required. For example, if the 

removed field was used to define a chart, you’ll have to create a 
new chart. 

6 Copy the modified .rpt files to the CUSTOMIZEDFILES folder. If 

you don’t, your modified custom reports will be overwritten the 
next time you generate the Web view. 

Note: In general, any time Crystal Reports asks you to either used 

saved data or refresh data, use the saved data. Refreshing the data 

requires that you select a data source, and the data source should be 

set only by Issue Tracker at run time (when a user views the reports). 
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Customizing the Issue Tracker User Interface 

It is possible to replace the logos used by Issue Tracker in a multiple areas: 

 Web views 

 Web Admin 

 HTML Reports 

 

Issue Tracker has two different logo files: 

Filename Dimensions RGB Matte Description 

logol.gif 200x60 #F7F9FF Used with dark backgrounds. For 
example, the Web views. 

logo.gif 166x45 #003366 Used with dark backgrounds. For 
example, the logon page. 

 

You will need to create replacements for these files, while respect the 

dimensions. This will ensure the best integration with Issue Tracker.  

When ready to place the new logos, keep in mind that there are multiple 

copies of Issue Tracker logos throughout the product – the ones that will need 

to be replaced depends on what you want to achieve.  

How to Change the Logos Used in the Web Views 

1 Copy the new logos to “C:\Program 

Files\Vector\IssueTrackerServer\CensusWeb\CUSTOMIZEDFILES
\#AllProjects#\Theme\images\logos”, as shown in the image 
below: 

 

 If some of those folders are missing (CUSTOMIZEDFILES and beyond), 

create them. 

2 Regenerate the web views. 
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How to Change the Logos Used in Web Admin 

1 Copy the new logos to “C:\Program 

Files\Vector\IssueTrackerServer\CensusWeb\Templates\Admin\T
heme\images\logos”, as shown in the image below: 

 

2 Regenerate Web Admin. 

How to Change the Logos Used in the HTML Reports 

HTML Reports use a path defined within an XML file when displaying logos. 

Changing this path would therefore change the logo displayed. The XML file 

in question could have one of two different names: 

 tmplrpt_listing_multicolumn.xml 

 tmplrpt_listing_tabular.xml 

1 Locate and modify the report XML file. 

You can find them at the path: “C:\Program 

Files\Vector\IssueTrackerServer\CensusWeb\Views\CensusWebVD\<project

>_<view>\Reports”, where <project> is a project name, and <view> is the 

name of the view you want to customize. 
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2 Copy the modified file to the CustomizedFiles folder. This will 

ensure that the changes are preserved even after the web views 
are generated. 

For example, the resulting location in CustomizedFiles could be: “C:\Program 

Files\Vector\IssueTrackerServer\CensusWeb\CustomizedFiles\#Project#Help

Desk\#WebView#Employee\Reports”, if you wanted to have the change 

appear only for the Employee view of the HelpDesk project.  

3 Regenerate the web views. 

 

Exercise: Using a Custom Logo in the Web Views 

1 Open the “Training” folder on your desktop. 

2 Open the “Customizing Issue Tracker” folder. 

3 Copy “logol.gif” and “logo.gif”. 

4 Create the appropriate CustomizedFiles folder structure that will 

allow you include customized files to be used in all projects 
within the Issue Tracker virtual directory. 

5 Create the necessary folders to hold the “logol.gif” and “logo.gif” 
images. 

6 Copy the “logol.gif” and “logo.gif” images to the folder to the 

correct folder, as created in Step 5. 

7 Click Start > All Programs > Vector > Issue Tracker Tools > 

Generate Web Views to regenerate the Web views. When asked 
which views to regenerate, select them all. 

8 Log into one of the web views, and confirm that the change is 

working. In some cases, you may need to clear the browser 
cache to see the change. 
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Advanced Workflow Techniques 

 

Exercise:  Create a Country / Region / State Workflow 

1 Create the fields, workflow template and rules required to 

update the workflow you created earlier to reflect the following 
diagram. 

 

 

 
User selects a value 
from the Country field 

United States Canada 

California 

Florida 
Nevada 

Minnesota 

New York 

Quebec 

Ontario 

Alberta 

Manitoba 

User selects a value 
from the State field 

User selects a value 
from the Region field 

West 
Central East 

South 
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Exercise:   

1 Create the fields, choice values, workflow template and rules 
required to create the workflow shown in the following diagram. 

 

User selects a value 
from the Progress field 

Assigned to 
Dev 

Assigned to 
Support 

Owner 

Assigned to 
Sales 

The Progress field 
value, once chosen, 
will automatically set 
the Owner field. The 
value used to 
populate the Owner 
field will depend on 
the Progress value 
chosen (Assigned to 
Support, Assigned to 
Dev, or Assigned to 
Sales), as well as the 
value in the 
associated field 
(Support Lead, Dev 
Lead, or Sales Mgr). 

  

For example: 
Selecting Assigned 
to Dev as the 
Progress value will 
automatically result 
in the value from the 
Dev Lead field being 
used to set the 
Owner field. 

 

Support Lead Dev Lead Sales Mgr 
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Creating Custom Macros for Queries 

Issue Tracker comes bundled with a few macros that can be used when 

defining queries: 

 <Today> 

 <First Day of Month> 

 <First Day of Quarter> 

 <First Day of Year> 

 <31 Days Ago> 

 <First Day of Week> 

Macros are useful for including dynamic values in your queries, like dates. For 

example, the value of the <Today> macro will be different depending on the 

day you use it, meaning the query results will differ accordingly. 

Macros are written in the VBScript programming language, and they are 

defined here: 

C:\Program Files\Vector\IssueTrackerServer\<Project>\Macro72.bas 

Custom macros should be defined in a different file: 

C:\Program 

Files\Vector\IssueTrackerServer\<Project>\CustomMacro.bas 

In both of the paths above, <Project> is the name of the project where you 

wish to add macros.  

Exercise: Add a date macro 

For this exercise, we’re going to create a macro that gives us the date 14 days 
ago. 

1 Navigate to the IssueTrackerServer folder. This is usually 

located at C:\Program Files\Vector\IssueTrackerServer\. 

2 Open the folder of the project you wish to add a macro. 

3 Within the project folder, you will find a file called Macro72.bas. 

Open this file with Notepad.The full path to this file, if you want 
to add the macro to the HelpDesk project, is: C:\Program 
Files\Vector\IssueTrackerServer\HelpDesk\Macro72.bas. 

4 Look through Macro72.bas and copy a function that is similar to 
the type of macro you wish to create. In our case, the macro 

GetMacro31DaysAgo is very similar to what we want.  

5 Copy the macro code from Step 4, and paste it into the 
CustomMacro.bas file, which is located in the same directory.  
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6 Edit the GetMacro31DaysAgo macro you placed in 

CustomMacro.bas so that all it works with 14 days ago rather 
than 31 days ago. Once you’re done, it should look like this: 

'----------------------------------------------------------- 

'NAME:          GetMacro14DaysAgo 

'DESCRIPTION:   Get the date 14 days ago 

'----------------------------------------------------------- 

Public Function GetMacro14DaysAgo(oCensusApplication, 

lngDtsRecordID, oExpression, recRevisionHistory) 

 

        Dim varDate 

         

        varDate = DateAdd("d", -14, Date) 

        GetMacro14DaysAgo = Year(varDate) & "/" & 

Month(varDate) & "/" & Day(varDate) 

 

End Function 

7 Open the project’s DEF database. In this case, we’re working 

with the HelpDesk project, so we need to open HelpDesk02.def. 

8 Locate and open tblMacros in the DEF database. 

9 Add a new row in tblMacros, containing the following values: 

ID tName tFunctionName nType nUsageType 

31 <14 Days Ago> GetMacro14DaysAgo 1 12 

 

The nID field is a unique identifier, so it must contain the next available ID. For 
example, if the highest ID is 30, the new row must have an ID of 31. 

The tName field holds the macro itself – this is what you will see in the Query 
Editor, <14 Days Ago>. 

The tFunctionName field should hold the exact name of the function you 
added to CustomMacro.bas, in our case, GetMacro14DaysAgo. 

The nType field specifies what arguments the function takes: 

1 = No Arguments 
2 = Issue Record 
3 = Revision History 
4 = Expression 
In our case, we want to use 1. 

The nUsageType field must be set to 12, which makes the macro available in 
the Query Editor. 

The new macro should now be available whenever you add a Date field to a 
query: 
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Advanced Notifications 

Changing the Format of Attachments  

The Detailed choice in the Include list of the Notification Editor attaches a 

report to the notification message. This report includes most fields for an 

issue.  

If you do not use Crystal Reports, attachments can be HTML files or text files. 

If you do use Crystal Reports, attachments are RTF files by default. You can 

change this to be PDF, text, or a number of other formats.  

To change the format of a notification attachment:  

1 Open the project definitions database. 

2 In tblMailContents, change the nFormatType for the 
attachments. (Attachments have nType = 3 in 
tblMailContents). 

Posible nFormatType constants:  

NoFormat 0 Lotus123WK1 12 Excel70 27 

CrystalReport 1 Lotus123WK3 13 Excel70Tabular 28 

DataInterchange 2 WordForWindows 14 Excel80 29 

RecordStyle 3 Excel21 18 Excel80Tabular 30 

RichText 4 Excel30 18 PortableDocFormat 31 

Comma Separated 
Values 

5 Excel40 20 HTML40 32 

TabSeparatedValues 6 Excel50 21 CrystalReport70 33 

CharSeparated 
Values 

7 Excel50Tabular 22 ReportDefinition 34 

Text 8 ODBC 23 ExactRichText 35 

TabSeparatedText 9 HTML32Standard 24 XML 36 

PaginatedText 10 Explorer32Extend 25  

Lotus123WKS 11 NetScape20 26 
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Attaching Information  

By default, the Revision Record and Summary are included in the body of 

the e-mail notification message. You can include this information as separate 

attachments.  

To do this, open the project definitions database and in tblMailContents 

change the nType to 3. nType determines where the content is put in the e-

mail message. 

nType Description 

1 Subject 

2 Body of e-mail message 

3 Attachment 

 

Adding Notification Reports  

Vector Issue Tracker can use reports to format information included in e-mail 

notifications. For example, the Detailed and Summary items are formatted by 

reports. You can define new reports and add them to the list of items that can 

be included in an e-mail notification message.  

Exercise: Add a New Report for Notifications  

1 In Issue Tracker Admin, use the Report Editor to define a new 

listing report. 

2 Save and preview the report. 

3 Exit Issue Tracker Admin. 

4 Open the project definitions database. 

5 Open the tblSystemCustomReports table, find the record for 

the report you just created, and get the nID value. 

6 Open the tblMailContents table and create a new record. 

Field Description 

nID Next available ID number for a record in the tblMailContents table.  

tName Name displayed in the Include list of the Notification Editor. 

nType 2 = include in message body  
3 = attachment 
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tFunction The GenerateReport function takes care of generating the report for the 
notification message. 

tArguments <nID>.10, where <nID> is the ID of the report in 
tblSystemCustomReports.  

nFormatType 4 = rtf  
8 = text  
14 = word  
31 = pdf  
32 = html40  

When nType = 2, nFormatType must be 8 (text).  

  

The report is now available in the Include list of the Notifications Editor.  

7 Create a notification using this include source. 

8 Test to ensure that the notification that you receive includes 

your new report. 

 

Note: If you’re using Crystal Reports for your listing reports, you’ll have to 

create a Crystal Report report file (.rpt) for the new notification report: 

 View the report in a Web view. 

This creates an .rpt file in the 

CensusWebVD\<project>_<view>\Reports folder. For example:  

\Program 

Files\Vector\IssueTrackerServer\CensusWeb\Views\CensusWebVD\

helpdesk_helpdesk\Reports  

 Copy the .rpt file to the IssueTrackerServer\<project>\Reports folder. 

For example: 

\Program Files\Vector\IssueTrackerServer\helpdesk\Reports  

 Rename the file by removing portrait (or landscape) from the .rpt file 

name. 
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Adding Custom Mail Contents  

In the Notification Editor, the Include list specifies what to include in an e-mail 

notification message. You can add items to this list. The items can be used as 

the message subject, inserted in the message body, or included as 

attachments to the message.  

To add an item to the Include list of the Notification Editor:  

1 Define a function in the CustomMacro.bas file.  

This function should return the content you want to include in 
the e-mail message.  

CustomMacro.bas is located in the project sub-folder of the 
IssueTrackerServer folder (for example: 

IssueTrackerServer\helpdesk\CustomMacro.bas)  

2 Open the project definitions database, and in the tblMacros 
table, add a row for the new function. 

tName is the name of the macro.  

tFunctionName is the name of a function defined in 
macroXX.bas.  

nType specifies what arguments the function takes:  

1 = No Arguments  

2 = Issue Record  

3 = Revision history  

4 = Expression  

3 In the tblMailContents table, add a row for the macro, using 

the same tName as in tblMacros.  

nType specifies where to include the contents:  

1 = subject 
2 = body 
3 = attachment  

nFormatType specifies the format:  

4 = rtf 
8 = text 
14 = word 
31 = pdf 
32 = html40  

When nType = 2, nFormatType must be 8 (text), otherwise the 
contents appears as a plain text e-mail message that contains 
RTF or PDF, which is never sent. This will hold up all your 
notifications.  
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Exercise: Create a Notification With Custom Mail Content 

1 Open the IssueTrackerServer\HelpDesk\CustomMacro.bas file 

with notepad. 

2 Enter the following functions: 

'Return a simple subject line 

Public Function _ 

GetCustomSubject(oCensusApplication, _ 

lngDtsRecordID, oExpression, recRevisionHistory)  

GetCustomSubject = "Your subject goes here."  

End Function  

 

'Return the contents of a text file 

Public Function GetCustomMsgBody( _ 

oCensusApplication, lngDtsRecordID, oExpression, _ 

recRevisionHistory )  

Dim fsObj  

Dim txtStreamObj  

Dim emailbody  

Dim strFileName  

strFileName = "C:\Messages\msg.txt"  

Set fsObj = CreateObject( _ 

"Scripting.FileSystemObject")  

Set txtStreamObj = fsObj.OpenTextFile( _   

strFileName, 1, False, False)  

emailbody = txtStreamObj.ReadAll  

txtStreamObj.Close  

GetCustomMsgBody = emailbody  

End Function  
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'Return a subject line that includes the value of a 

'field 

Public Function GetSubject(oCensusApplication, _ 

lngDtsRecordID, oExpression, recRevisionHistory)  

Dim lngLastRevisionNumber  

Dim rstValue  

Dim variablename  

If oCensusApplication Is Nothing Then  

Exit Function  

End If  

If recRevisionHistory Is Nothing Then  

Exit Function  

End If  

'get the last revision number  

GetRevisionNumberRange recRevisionHistory, 0, _  

lngLastRevisionNumber  

' Get the value for the field from the table  

' of the last revision in the given set.  

Set rstValue = oCensusApplication.CurrentProject._  

DataStores.Item(32). _  

GetConnection(1).Execute( _  

 "SELECT tBriefDescription FROM tblDts_History_  

 WHERE nID=" & lngDtsRecordID _  

 & " AND nRevisionNumber=" _  

 & lngLastRevisionNumber, , 1)  

' Build subject line that looks like:  

'HELPDESK [Ticket 37] - Cannot print PDF file  

If Not rstValue.EOF Then  

 If Not IsNull(rstValue.Fields(0).Value) Then  

  GetSubject = "HELPDESK [Ticket " &_  

     lngDtsRecordID & "] - " &_  

     rstValue.Fields(0).Value  

 End If  

End If  

End Function 
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3 Create a text file in C:\Messsages\ called msg.txt. Add a custom 

body content to this file. The second function above will read 
this file and use it in the notification. 

4 Open the project definitions database, and in the tblMacros 

table, add a row for each of the new functions: 

ID tName tFunctionName nType 

31 <Simple Subject> GetCustomSubject 3 

32 <Body From File> GetCustomMsgBody 3 

33 <Subject With Val> GetSubject 3 

 

5 In the tblMailContents table, add a row for each of the 

macros: 

nID tName nType nFormatType 

5 <Simple Subject> 1 8 

6 <Body From File> 2 8 

7 <Subject With Val> 1 8 

 

6 Create notifications using these include sources. 

7 Test to ensure that the notifications that you receive include the 

custom mail content. 
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CustomCode.bas – DIY Power Customizations 

Issue Tracker allows you to customize the process of creating and saving 

issues via a file called CustomCode.bas. Each web view has such a file 

within its folder structure – here is an example path: 

<IssueTrackerServer>\CensusWeb\Views\CensusWebVD\HelpDesk_Employ

ee\HTML (Where <IssueTrackerServer> is the path of the 

IssueTrackerServer directory – typically: C:\Program 

Files\Vector\IssueTrackerServer). You can also place this file in the 

appropriate CustomizedFiles folder(s) to ensure the web view regeneration 

process preserves it. 

You have the option of adding your own customized code to the following 

events: 

 OnAddNewRecord 

 OnCopyRecord 

 OnValidate 

 OnBeforeSave 

 OnFieldSave 

 OnAfterSave 

The programming language used in CustomCode.bas is VBScript. These 

events, written as VBScript functions, allow you to place your own code in 

different contexts – for example, “OnAfterSave” allows you to customize what 

happens after the issue is saved. Within the CustomCode.bas file, you will 

notice calls to internal functions, prefixed with “Mq_”. These functions are 

stored in MqCustomCode.bas, which is an internal file that should not be 

edited. Custom code should only be added to the CustomCode.bas file. 

Below are a few examples of the customizations you can make to the way 

Issue Tracker works. 

Exercise: Apply the custom functions  

1 Open the CustomCode.bas file from your Web view with 

Notepad. 

2 Locate each section, and add the custom code examples from 
below. 

3 Test the changes within the Web view 

4 When they work as expected, copy the CustomCode.bas file to 

the appropriate CustomizedFiles folder. 
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Example 1 – OnCopyRecord 

Custom code that automatically adds the text “Copied Issue:” to the beginning 

of the Brief Description field upon copying an issue. 

Public Function OnCopyRecord(objApp, rs, lngRecordID, lngUserID) 

 ' DESCRIPTION: 

 '   This function will set the default values for fields in a  

'   copied record  

 

 ' RETURN VALUE: 

 '   Info: not used 

 Const FLD_BRIEF_DESCRIPTION = "tBriefDescription" 

 Const LBL_COPIED_PREFIX = "Copied Issue: " 

 Dim strBriefDescription  

  

 ' Retrieve the current brief description text 

 strBriefDescription = objApp.GetFieldValue(rs, _ 

FLD_BRIEF_DESCRIPTION) 

  

' Check to see if the Copied Prefix “Copied Issue: “ is present. 

 If InStr(strBriefDescription, LBL_COPIED_PREFIX) = 0 Then 

   

' The prefix is missing. Add it:  

  strBriefDescription = LBL_COPIED_PREFIX & _ 

strBriefDescription 

 

  ' … and then save the updated value. 

 Call objApp.SetFieldValue(rs, FLD_BRIEF_DESCRIPTION, _ 

strBriefDescription) 

 End If 

  

 ' Proceed with the copy operation. 

 Call Mq_OnCopyRecord(objApp, rs, lngRecordID, lngUserID)  

End Function 
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Example 2 – OnAddNewRecord 

This example illustrates how the AddNewRecord function can be used to set 

some default values. 

 

Public Function OnAddNewRecord(objApp, rs, lngRecordID, lngUserID) 

 ' DESCRIPTION: 

 '   This function will set the default values for fields in a new  

'   record. 

 ' RETURN VALUE: 

 '   Info: not used 

  

 Const FLD_SOURCE = "nSource" 

 Const VALUE_SOURCE_WEB = 1 

  

 ' Update the nSource field to have a value of 1, which is “Web”. 

 ' If the user has a default value configured for the nSource field, 

 ' the default value will be applied – our change here will not be  

' seen. 

 ' This is an interesting way to enforce a default for all users  

' that currently don’t have any defined. 

 Call objApp.SetFieldValue(rs, FLD_SOURCE, VALUE_SOURCE_WEB) 

  

 ' Proceed with the regular add new operation. 

 Call Mq_OnAddNewRecord(objApp, rs, lngRecordID, lngUserID) 

End Function 
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Example 3 - OnFieldSave 

This example illustrates how you would modify a field value as it is being 

saved. 

Public Function OnFieldSave(objApp, cfield, varCurrentValue, _ 

ByRef strChangedFields) 

 ' DESCRIPTION: 

 '   This function will allow user to add custom code to further  

 ' modify the record based on another field value. For example, in    

 ' the Mq_OnFieldSave function, if we determine that the record was  

 ' closed, we set the fields close date and close time. 

 ' RETURN VALUE: 

 '   Type: boolean 

 '   Info: return true if you changed the strChangedFields list 

 ' Argument strChangedFields: a comma seperated list of changed  

 ' fields. Add the related fields that you've changed. 

  

 Const FLD_BRIEF_DESCRIPTION = "tBriefDescription" 

 Const LBL_UPDATED = "Updated: " 

  

 'If the field is the brief description field... 

 If cfield.FieldName = FLD_BRIEF_DESCRIPTION Then 

   

  'Check to see if the "Updated: " string is already there. 

  If InStr(varCurrentValue, LBL_UPDATED) = 0 Then 

    

   'The string is missing, add it. 

   varCurrentValue = LBL_UPDATED & varCurrentValue 

    

  End If 

 End If 

  

 OnFieldSave = Mq_OnFieldSave(objApp, cfield, varCurrentValue, _ 

strChangedFields) 

End Function 
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Example 4 – OnValidate 

This example is a little more advanced – it illustrates how you would go about 

enforcing custom validation rules, in addition to the standard Issue Tracker 

rules. 

 

Public Function OnValidate(objApp, lngRecord, dctFldVals) 

 ' DESCRIPTION: 

 '   This function will allow user to add custom validation before 

saving the record. 

 '   Here you can do validation specific to your needs. 

 ' RETURN VALUE: 

 '   Type: string 

 '   Info: If the returned string is not empty, the save action is 

canceled and 

 ' the string is displayed to the user. 

 

 Const FLD_SEVERITY_ID = "19" 

 Const FLD_BRIEF_DESCRIPTION_ID = "30" 

 Const MIN_LEN_BRIEF_DESCRIPTION = 3 

 Const MSG_SEVERITY_NOT_SET = "The Severity field must be set. Enter 

a value and try again." 

 Const MSG_BRIEF_DESCRIPTION_TOO_SHORT = "The Brief Description 

field must be at least 3 characters long. Enter a new value and try 

again." 

  

 Dim strSeverityID 

 Dim strMessage 

 Dim blnValidationFailed 

  

 'Start off thinking the validation is going to be successful. 

 'If any of the steps fail, they will change this boolean to true. 

 blnValidationFailed = False 

 

  'Validate Brief Description field... 

  If dctFldVals.Exists(FLD_BRIEF_DESCRIPTION_ID) Then 

 

strBriefDescription = dctFldVals.Item( _  

FLD_BRIEF_DESCRIPTION_ID) 

 

'Does the Brief Description field meet the 3  

'character minimum length? 

If Len(strBriefDescription) <  

MIN_LEN_BRIEF_DESCRIPTION Then 

    

'No, it does not meet the minimum length 

'requirement. 

    'Show the user a message. 

    strMessage = MSG_BRIEF_DESCRIPTION_TOO_SHORT 

 

    'Mark the validation step as failed. 

    blnValidationFailed = True 

 

   Else 

    'Description field validated fine. 
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    'Validate Severity field... 

    If dctFldVals.Exists(FLD_SEVERITY_ID) Then 

     strSeverityID = dctFldVals.Item( _  

FLD_SEVERITY_ID) 

      

     'Check to see if the Severity value is  

'blank. 

     If strSeverityID = "" Then 

      

        'The field is blank. 

        'Tell the user. 

        strMessage = MSG_SEVERITY_NOT_SET 

       

        'Mark the validation step as failed. 

        blnValidationFailed = True 

 

     End If 

    End If  

   End If 

  End If  

 

   

  'Did the validation fail? 

  If blnValidationFailed Then 

   

   'Yes it did...  

'show the user the validation failure message. 

   OnValidate = strMessage 

  Else 

   'No... validation finished successfully.  

'No problems found. Proceed as usual: 

   OnValidate = Mq_OnValidate(objApp, lngRecord, _  

dctFldVals) 

  End If 

 

End Function 

 

 

 


